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Preface
The subject “Computer Shikhon O Shikshon” (Computer Applications in Education) has been organized 
as per NCTE’s newly developed syllabus, 2014. The course of this subject is scheduled for completion 
of two years and is included in the curriculum of ‘Diploma in Elementary Education (D.El.Ed.). The 
main objective of this curriculum is to transform the environment and methods of education as per 
the National Curriculum Framework for Teacher Education (NCFTE 2009). This transformation is 
absolutely necessary to keep up with today’s rapidly changing society, environment and lifestyle. The 
revision of the syllabus and the annexation of the paper have mainly been made with this change in 
mind. It should be noted that the content of the book is by no means limited to written subjects. Only 
outlines and guidelines are provided in this.

The main objectives of writing this book are-

a)	 To take a holistic view of various educational subjects.

b)	 To acquire knowledge about basic concepts in human nature, society, learning and goals of education.

c)	 To acquire knowledge about various components of education.

d)	 To form concepts between learning and teaching by the teachers.

e)	 To gain knowledge about different approaches to curriculum and child knowledge construction.

f)	 To acquire knowledge about school leadership, management, effectiveness and its quality.

This textbook is a joint research work of State Council of Educational Research and Training (SCERT, 
WB) and District Institute of Education and Training (DIET). Due to lack of suitable textbooks for 
the new D.El.Ed course in Teacher-Education Institutions, this body vide Government Instruction 
712-Edn (CS)/8T-17/79, dated 21.05.1980 Sections (iii), (iv), (viii) and (x)) undertook and project 
called “Development of Teaching Clarity”. The words that emerged emphatically from the teachers-
trainers present at each of these project workshops were “D.El.Ed needs the right teaching and learning 
materials”.

This book is the result of tireless efforts of every staff member of State Council of Education Research 
and Training (SCERT), and various District Education and Training Institutes (DIETS). The content of 
this book was developed through a number of processes. All efforts will be worthwhile if it is welcomed 
in the teacher-education programme. Our next generation will be properly educated if this process is 
transformed through the application of “Computer Shikhon O Shikshon” (Computer Applications in 
Education) in the field of education. The content prepared through initial application and research is 
then subjected to final editing. It is through these stages that this book emerged today.

The contributions from Dr. Chhanda Ray, Director, SCERT (WB) in writing the original Bengali version 
of this book is commendable.

Under requests from various TEIs with medium of instruction other than Bengali, SCERT, WB, 
subsequently embarked on a project to get this body work, amounting to 10 titles in all, to get translated 
in English, Urdu and Santhali. The translation work was taken up in teams under the supervision of 
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the Director, SCERT (WB), and under coordination of Shri Subrata Kumar Biswas, Research Fellow, 
Grade-II, SCERT (WB). The team for transcreating the present book constituted of Sri Sombhu Some, 
Assistant Technician, Computer, DIET Jalpaiguri.

Since this work of translation work can best get critiqued while in use by the practicing teacher educators 
and the D.El.Ed trainees, any constructive criticism by way of suggestion to improve the present book 
is heartily solicited.

The effort gone into this transition will get its due recognition if this book meets the requirements of its 
readers.

Dr. Chhanda Ray 
Director, SCERT (WB)
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UNIT
1

Basic Concepts of Computer 

1.1 Introduction

1.2 Objectives of the Unit

1.3 History of Evolution of Computer

1.4 Some common Functions/Operations of Computer

1.5 Various Features of the Computer System

1.6 Structure of a Computer System

1.7 Software

1.8 Summary

1.9 Unit End Exercise

1.1 Introduction 

The word computer comes from the latin word “Compute.” 
- which means to calculate. A computer can not be understand 
properly just as a Computing device. A computer may be defined 
as a complex electronic system which can produce output step 
by step depending on the input data through logical and 
mathematical operations. It is a high speed device and also 
produces output by processing of input using various peripheral 
devices attached with the system. The main function of a 
computer system is to collect data or input, process the input 
and output the result and store the output if and when necessary. 

Input → Process → Out put → Store (if necessary)

Computer is the best invention of 20th century. But it could not be 
done in an over night. About 4000 years ago China first invented and 
used ‘Abacus’ as a calculating device. In the year 1617 Jhon Napier 
invented another calculating device Napier’s Bone. Another remarkable 
invention was William Oughtred’s “Slide Rule”. In the year 1642 the 
French Mathematician Blaise Pascal invented an advanced calculating 
device known as Pascaline machine- which could performe addition and 

Fig.1.1 Abacus

Fig -1.2 Charles Babbage
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Subtraction automatically. Later in 1823 Charles Babbage developed Difference Engine- which could 
perform mathematical as well as statistical calculations. In 1837 he developed more powerfull device 
from Difference Engine known as Analytical Engine. Analytical Engine was the first ancestor of modern 
Computer. So Charles Babbage is known as the father of modern computer. 

1.2 Objectives of the Unit 

After reading of this unit learners will be able to - 
•	 Understand the architecture of a of computer system and the functions of its various parts. 
•	 Know the history of evolution of Computer and its various generations. 
•	 Understand the features and configuration of a computer system. 
•	 Describe the general functions and classifications of Computer System. 

1.3 History of Evolution of Computer 

At the end of 19th century, Dr. Herman Hollerith and James Powers developed ‘Census Machine’ for 
processing of census data in America. This machine was able to analyse both type of data alphabetical 
as well as numerical. In 1896 Hollerith established a company named “Tabulating” for manufacturing 
of census machine. Later some of these types of companies were marged to form the famous company 
named IBM (International Business Machine). At the earlier of 1990 the electromagnetic MARK-I was 
developed. Later in the same year first electric computer ENIAC (Electronic Numerical Integrator and 
calculator) was developed 

Depending on the characteristics and the period of development the computers which were developed 
after the invention of ENIAC were classified into five various generations, such as First generation, 
Second generation, Third generation, Fourth generation and Fifth generation. The characteristics of 
each generation of computers are described as below —

First generation (1942-1959): 

Some remarkable Computers of 
this generation are ENIAC, EDVAC, 
UNIAC-I, IBM 650, IBM 701 etc. The 
main characteristics of these generation 
are–
•	 The main component was vaccum 

Tube.
•	 These machines were of large size.
•	 Magnetic drum and magnetic tape 

were used as primary and secondary 
memory respectively. 

•	 Earlier machine language was used in this generation Computers but later on Assembly language 
was used in these computers. 

Fig.1.3 First Generation Computer
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Second Generation (1959-1965): 

Some remarkable computers of this generation are – IBM 1400, 1BM 700, HONEY WELL 200 etc. 
The great scientists like Bardeen, Brattain and Shockley first unitedly invented Transistor in the Bell 
Laboratory. The second generation of Computers was started with the use of this transistor insted of 
vaccum tubes. The general characteristics of this generation computer are — 
•	 Transistors were used as main component.
•	 Size of these computers were smaller than that of first generation computers. 
•	 Magnetic core was used as memory. 
•	 Various High Level Languages like COBOL, BASIC PL/1 were started to use in this generation 

Fig.1.4 Second Generation Computer

Third Generation (1965-1971) 

Some important computers of this 
generations were IBM 360, 370, NCR 395 
etc. This generation was started after the 
invention of IC or Integrated Circuity. The 
general characteristics of third generation 
computers are —
•	 IC or Integrated Circuit was used as main 

component. 
•	 The size of the computers were 

comparatively smaller than that of earlier 
generations. 

•	 Use of keyboard and Monitor was started as input and output device respectively. 
•	 Magnetic disk was used as secondary memory. High Level Languages like PASCAL, FORTRAN 

etc. was started to use from this generations. 

Fourth Generation (1971-1998) 

The Computers of this generation were-3086, 30286, 30486, Pentium etc. The fourth generation 
of computer was started with the use of LSI (Large Scale Integration) and VLSI (Very Large scale 
Integration) circuit. The general characteristics of fourth generation Computers are –

Fig.1.5 Third Generation Computer
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•	 LSI and VLSI circuits were used as main Component 
•	 use of Mouse, Printer and speaker 

was started from this generation 
•	 The size of computers of this 

generation was quite smaller than 
that of other earlier generations. 

•	 Use of high capacity storage 
magnetic disk, CD-ROM etc. was 
started in this generation. 

•	 The high level languages like C, 
C++, visual Basic etc. and various 
Packages like word processing, Spread Sheet, Database were started to use successfully from this 
generation. 

Fifth Generation (1998 and onwards) 

In this generation research on more powerful and Artificial Intelligence supported Computers is going 
on. The general characteristics of this generation computers are –
•	 ULSI (Ultra Large Scale Integration) circuit is used as main component. 
•	 Use of LCD and LED monitors are started. 
•	 The size of computers in this generation become quite smaller and portable. 
•	 The Intelligence programming based on Artificial Intelligence has developed started to use 

generation computers. 
•	 High storage capacity Hard Disk is used in these computers. 

1.4 Some common Functions/Operations of Computer 

A Computer system is made up of various devices which are collectively known as hardware. 
Some of such devices are Processor, Mother Board, Monitor, Disk drive, Key Board, Mouse etc. The 
instructions specific to a computer and the data or informations which can not be visible or touched are 
known as Software. A Software is basically a computer programme which is written as a set of data as 

Fig.1.6 Fourth Generation Computer

Fig.1.7 Fifth Generation Computer
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well as instructions for a computer system. Thus it can be said that a computer system is an electronic 
device which consists of Hardware and Software. 

Generally the functions of a computer can be classified into four categories. Such as —
•	 Input 
•	 Processing 
•	 Storage 
•	 Output 

Input :

The raw facts and figures depending on which a Computer generates information is known as 
Data. e.g. to calculate the average of two or more numbers it is required to input the numbers into the 
computer. These numbers are known as data. The output generated by processing of data is known as 
information. In the earlier example the average is known as information and the numbers are known as 
data. The information obtained from one processing may act as data for another processing. 

The data or information which are required to enter into the computer for a particular processing is 
known as input. The input are entered into a computer using Keyboard, Mouse etc. These devices are 
known as input device. 

Processing: 

The manner by which data or informations generated by processing of data are stored arranged 
as per requirement temporarily or permanently into a computer system to use it in future is known as 
storage. 

Output: 

The result obtained after processing of data is known as output. Such output displayed to the outer 
world through the monitor or may be printed by the printer. 

Imput Processing

Storage

Outputdata data

data

Fig-1.8 Function of a Computer System 

The function of a Computer System has been shown in the fig-1.8. To describe the function more 
elaborately an example may be considered. Let us take ten numbers and find the largest and the smallest 
of them. To perform this task, first ten numbers must be given as input to the computer system. By 
processing the data from these inputs, the computer will identify the largest and smallest numbers as the 
output. This output can be stored temporarily or permanently in the computer for later use or the output 
can be displayed to the outside would through monitor. 
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• Classification of Computers 

Computers are classified into different categories based on different issues. Computer Systems can 
be divided into three categories depending technology on the technology used in the computer. For 
example — Analog Computer, Digital Computer and Hybrid computer. These are explained below — 
	 i)	 Analog Computer: These type of computers perform tasks by measurements rather than 

calculations, e.g. car speedometer. 
	 ii)	 Digital Computer: These type of computers relies on numerology. In short, this type of computer 

is a computing device and this type of computer is widely used in general. 
	 iii)	 Hybrid computer: Computers that have both the characteristics of analog as well as digital 

features are known as hybrid computers. 

The type of computer most commonly used today is the digital microcomputer or personal computer. 
Various classifications of computers are mentioned below - 

Computer

Analog Computer Digital Computer Hybrid computer

Super 
Computer

Main frame 
Computer

Mini 
Computer

Micro 
Computer

Computer system can be further divided into four Categories based on size, volume, shape and 
performance. E.g. – Super computer, Mainframe Computer, Mini Computer and Micro Computer or 
Personal Computer or PC. These are described as below —
•	 Micro Computer: These computers most widely used computers made up of microprocessors. 

With the advancement of technology there have been many changes in the shape of these computers. 
Micro Computers again can be classified into different category. E.g. - Desktop computer, Laptop 
computer, Notebook computer etc. Micro computer is smallest in size. 

•	 Mini Computer: These type of computers are longer, expensive and more powerful in functionality 
than micro computers. Mini computers were invented to serve multiple users simultaniously and to 
perform their task, 

•	 Mainframe Computer: This type of computer has relatively high storage capacity and processing 
speed. Due to large number of terminals connected to this computer, many people can use it 
simultaneously. Banks, Insurance Companies and Railways where there is a need to serve many 
people at once, there mainframe computers are used. 

•	 Super Computer: These types of computers are the most powerful and can perform more complex 
and large tasks at a fastest speed. Usually this type of computer is used for performing complex 
scientific and technical tasks and research work. 
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1.5 Various Features of the Computer System: 

A computer is an electronic device. The Salient features of the computer are described below— 
•	 Speed: A Computer can complete a complex task quickly according to given instructions. The 

working speed of a computer is measured in Mili seconds (10-3 second), Micro second (10-6 
second), Nano second (10-9 second) Pico second (10-12 second), Famto second (10-15 Second) and 
Alto Second (10-18 second), etc. 

•	 Accuracy: Computers have no other substitutes for accurate calculations. Computers are capable of 
working uniformly with equal efficiency from start to end of a calculation. However computer gives 
completely correct results only when there is no error from user’s end. 

•	 Storage Capacity: A large amount of information can be stored by the computer in its memory or 
storage area and from there the information can be used further work as required. The information 
stored in a computer system can be deleted according to given instruction. 

•	 Deligence: Computers can perform the same task repetedly and accurately in a short period of time. 

•	 Automation: Depending on given required instruction computer can carry out the instruction 
automatically without any assistance. 

•	 Versatility: Computer can performe a variety of task simultaneously. For example one can listen 
music, copy a file and write a letter at the same time through a computer. 

1.6 Structure of a Computer System

A computer system is made up of various components and these components are called computer 
Hardware. The various parts of a computer are connected to each other through a electrical connection 
and can perform necessary functions. Generally a computer system is made up of four component or 
unit. For example - Input unit, Output unit, Central Processing unit and Memory unit. These units are 
described in detail below— 

1.6.1 Input Unit: 

The Unit through which data and necessary instructions are given to the computer to complete any 
task with the help of a computer is called input unit. The device that is used to perform the necessary 
functions of the input unit is known as input device. Some input devices are discussed below–

•	 Keyboard: It is an input device and is used to 
provide input directly into the computer to perform 
a function. The keyboard is very similar to a typical 
type writer. There are basically three types of keys in 
the keyboard. 

1.	 Numeric keypad : It is consists of 0, 1, 2, ...9, +, 
-, ×, / keys.

2.	 Alpha Numeric Keypad: It is consists of A, B, C,.... Z keys. 

Fig.1.9 Keyboard
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3.	 Functional Keypad: At the very top of the Keyboard the 12 keys from F1 to F12 is known as 
functional keypad.

•	 Mouse : Mouse is also an input device. It is generally used to fix the position of the 
cursor on the monitor screen. A mouse usually has two buttons, one is the right button 
and the other is the left button. 

•	 Scanner: It is an essential input device. Any document or picture can be scanned 
with the help of this device and later the scanned image can be edited if needed. 
Different types of Scanner are available. For example – Flat bed Scanner, Drum 
Scanner etc. 

1.6.2 Output Unit

The unit through which the proper result of after the processing of input data or 
informataion given to a computer is displayed to us — is known as output unit. The device which is used 
to perform the necessary functions of the output unit is known as output device. For example Monitor, 
Printer, Plotter, Speaker etc. are used as output device. 
•	 Monitor (VDU): VDU or Visual Display Unit or Monitor is an output device. CRT (Cathode Ray 

Tube), LCD (Liquid Cristal Display) and LED (Light Emitting Diode) are three types of monitors 
which are commonly used.

Fig-1.12 VDU or Moniter 
•	 Printer: Through this output device any information is expressed in printed form on paper. Different 

types of printers are available. For example Laser-Jet Printer, Ink-Jet printer, Dot-Matric Printer etc. 

Fig -1.13 Printer 

Fig.1.10 Mouse

Fig.1.11 Scanner
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1:6.3 Central Processing Unit (CPU): 

Central processing unit is a key part of Computer System. It is actually an integrated circuit (IC) or 
chip. It usually consists of two subunits, namely Arithmetic Logic Unit (ALU) and Control Unit (CU). 
These two units are described below— 

Arithmetic and Logic Unit:

All types of mathematical and logical operations of the computer are performed by this subunit. It 
consists of three types of registers namely storage registers, accumulator and adder. Registers are small 
memory units located within the CPU and used to store intermediate data during CPU – Processing. The 
storage registers of this Sub unit are used to temporarily store the data and instructions required while 
performing a task. 

Control unit:

This unit controls the processing flow within the CPU. To complete a task, the co-ordination between 
the required data and instruction is the main function of this sub unit. 

1.6.4 Memory:

Through this unit, the necessary data processing in the Computer System is done both before and 
after the processing and can be mainly divided into two parts depending upon the storage capacity, 
speed, cost and location. These are Primary Memory and Secondary Memory. 
•	 Primary Memory: The memory without which a computer cannot be operated in any way is called 

Primary Memory. Primary memory generally sub divided into two such as – RAM (Random Access 
Memory) and ROM (Read Only Memory). The data stored in the RAM is temporary in nature and 
can be read and write arbitarily. The data stored in the ROM is permanent in nature and no new data 
can be written in it, the stored data in the ROM can only be read. 

•	 Secondary Memory: Apart from primary memory, other less expensive memory used to store huge 
amount of data into the computer is known as secondary memory. The data stored in this memory 
is permanent for long term. basis i.e. even if the computer is turned off the information remains in 
the memory as it is. As Secondary memory is located farther from the CPU than primary memory, 
data accessing from the secondary memory is much slower than that of primary memory. Floppy 
Disk, Hard Disk, CD ROM etc. are the example of secondary memory and are described briefly as 
follows - 

Floppy Disk: It is like a square disc made of plastic and coated with magnetic oxide on both sides. 
Generally 3.5 inch and 2.5 inch floppy disks more common in the market. Data is stored in this disk 
using the magnetizing process. 

Hard Disk: A type of magnetic disk with a higher capacity to store a relatively large volume of data 
is known as Hard Disc. Like many floppy disks arranged in a colum, the internal structure of a hard 
disk is like that. This disk has a read-write head. The entire system is kept in a hard box for security of 
the hand disk. Nowadays 500GB-1000 GB hard disks are more available in the market. Other than the 
above units, mother board is specially remarkable in a computer system. The important devices of a 
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computer system like Processor, RAM, Graphics Card, Sound card etc. are installed in the in the mother 
board. There are different companies’ mother board are available in the market, however Intel’s mother 
board is more popular. 

1.7 Software

Computer hardware are cannot operate the computer by itself. The programmes which control 
the computer hardware and help a computer to run or complete various tasks, is known as software. 
Depending on the functional area software can broadly be divided into two categories, such as – 
Application software and System Software.
•	 Application Software: The softwares that are able to perform a various alike functions 

simultaneously related to a particular job are called application software. For example MS-Word, is 
capable to perform all the jobs related to would processing. 

	 Among the application softwares, there are some Softwares which are able to perform only one 
single task. Such software is sometimes called utility software. For example Partition Magic is an 
application software which is only responsible for disk partition. 

•	 System Software: The software that communicates between the various parts of the computer and 
acts as a link between the computer hardware and application software is called System Software. 
The operating systems (OS) like Windows, Linux etc. are example of  system software. 

1.8 Summary 
•	 Abacus — is called as the ancestor of Computer. 
•	 Charles Babbage, who invented the Analytical Engine, is called the father of the modern computer. 
•	 The computers invented at different times are classified into five generations. 
•	 Depending on the functions computers are divided into three categories into analog, digital and 

hybrid. The most common type of computer at present is digital micro computer or Personal 
Computer (PC). 

•	 Information is supplied to the computer through various input devices (mouse, keyboard, Scanner 
etc.). This data is processed (Central Processing Unit) with other data or information to output 
logical results displayed or printed through the output devices (monitor, printer, speaker etc.). 

•	 To store various information in the computer, primary memory (RAM, ROM) and secondary 
memory (Hard disk, Pen drive) etc. are used. 

1.9  Unit End Exercise 
	 1)	 What is computer? 
	 2)	 Mention the various classifications of computers. 
	 3)	 Mention the special features of computers. 
	 4)	 Discuss the comparison among the various computer generations. 
	 5)	 Draw the block diagram of a computer and describe the functions of different parts of computer. 
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	 6)	 write notes on: 
a) Personal Computer (PC),  b) key-board,  C) Mouse,  d) CPU 

	 7)	 Give example of: 
a)	 Two input and two output devices 
b)	 Two devices which used as a input and output device 
c)	 Two storage devices 

	 8)	 write the full forum of RAM, ROM, LED, LCD, CRT, VLSI, IC, HDD 
	 9)	 Give light on fourth generation of computer. 
	 10)	 Differentiate between analog and digital computer. 
	 11)	 Write what you understand about input, Processing and output of a computer. 
	 12)	 What is Pico Second ? 
	 13)	 Explain the versatility of computer with an example?
	 14)	 Differentiate Hardware and Software 
	 15)	 What is meant by input and output device in computer? 
	 16)	 Write the names of different printers. 

Project work: 
a)	 Write the names of following hardware devices. 

(1)

(4)

(2)

(5)

(3)

(6)
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(7)

(10)

(13)

(8)

(11)

(14)

(9)

(12)

b)	 Draw the following picture and colour it with the help of MS- Paint using mouse.
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UNIT
2

Computer Operating System

2.1 Introduction

2.2 Objectives of the Unit

2.3 Computer Memory

2.4 Software

2.5 Programming Language

2.6 Operating System

2.7 Computer Network

2.8 Summary

2.9 Unit End Exercise

2.1. Introduction

This chapter discusses computer memory, operating system and computer network in detail. 
Memory is an essential part of computer system where various information and various instructions 
given to the computer are stored. These data and instructions may be provided through various input 
components, and may also be partial results of intermediate stages during computer processing. When 
performing a task, the computer takes information and necessary instructions from this memory area. 
Operating system is a very important part of computer. The operating system controls the components 
or hardware of the computer and creates a suitable environment to run the programs (software) required 
for a particular task. In short, the operating system establishes the link between the computer hardware 
and application software and ensures that the entire computer system can function smoothly. A computer 
network is a connection system between many computers through which the connected computers can 
exchange various information (such as written text, words, images, videos, etc.) with each other. 

2.2 Objectives of the Unit:

After reading of this unit learners will be able to-
•	 Describe the computer memory and broad classification of memory (primary memory, secondary 

memory and their classification). 
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•	 Identify the characteristics and comparison of primary and secondary memory and different 
classifications of RAM and ROM. 

•	 Demonstrate the concept and classification of software (system software, application software and 
utility software). 

•	 Know the detailed information about the operating system. 
•	 Define the computer network and its classification and various network technologies and their 

advantages, disadvantages etc. 

2.3 Computer Memory 

Information and instructions are stored in the form of binary code in computer memory. The binary 
code is 0 and 1. It consists of a type of code on which modern digital computer systems are based. 
Memory consists of small cells or spaces where information and instructions are stored. These are called 
cells. In order to get back the information or data previously stored in the memory, the address of the 
location of the cell in which the information is stored has to be told. In this case, it is not necessary for 
the user to know the specific address of the bank because the computer’s operating system does this 
automatically. The information or data stored at any address can be used as many times as desired, but 
when any new information is stored at that address, the previously stored information is deleted. Again. 
user can delete data from any address as per requirement.

A computer system may use several different types of memory. Depending on the size of the memory, 
location of the memory in the computer, performance etc., different types of computer memory are 
classified. Computer Memory can be mainly divided into two parts. For example- 
•	 Primary or Main Memory and 
•	 Secondary/Auxiliary Memory 

These are discussed in detail below. 

2.3.1 Primary Memory: 

Primary memory or main memory can be called the ‘real brain’ of the computer system. In a 
computer system, the primary memory is located after the CPU and the data and instructions required 
for specific tasks are stored here. When a program is executed in a computer system, it must be stored in 
the primary memory at that moment. Because CPU can only directly access programs and data located 
in primary memory. So without the help of this memory a computer cannot perform any task at all. 
Different parts of primary memory are again dedicated to perform different tasks. 

Primary memory is divided into four parts as shown in the figure below. 

Input storage area

(Before processing data 
and instructions until is 
stored here)

Program storage area

(Programs or 
instructions Stores 
here)

WorkingStorage Area

(Data or program 
in progress and 
intermediate results are 
stored here)

Output storage area 

(Results obtained after 
processing are stored to  
be presented in output 
form in this section) 



15

The storage capacity of primary memory depends on how many addresses are in this part and how 
many bits or information can be stored in each address. There are two types of memory used in primary 
memory. These are- 
•	 Random Access Memory (Random Access Memory or RAM) And 
•	 Read Only Memory (Read Only Memory or ROM) 

Random Access Memory 

Random access memory is a type of memory in which any 
necessary information can be read from any location and the 
information can be written as needed at any location. Random 
Access Memory or RAM is the part of primary memory 
where application programs and currently used data stores for 
processing. All data coming from the input device is stored 
in RAM for processing. The CPU then processes the data or 
instructions from the RAM, produces the required results and 
sends them back to the RAM for storage. By using the address 
stored information can be read from any location of RAM and 
new information can be written to any location. 

This reading and writing or Accessing is not done in any specific order, but randomly. That’s why 
this memory is called random access memory. RAM is also called read/write memory because both 
reading and writing can be done here. Information is stored in RAM on the basis of electrical charge, 
so when the computer is switched off or the power goes out for some reason, all the information stored 
in RAM is deleted. RAM is active as long as the computer is running. That’s why RAM is also called 
Volatile Memory. 

During computer booting, the operating system is copied from the secondary memory or storage 
to the RAM located in the primary memory and makes the computer system useful for performing 
various tasks. In a computer system, RAM is placed in banks in the motherboard. Currently, RAM 
is available in different storage capacities like 512 MB, 1GB, 2GB, 4GB, 8GB etc. The computer’s 
temporary memory can also be increased by installing additional RAM as needed. Additional RAM is 
often required to run advanced application programs. The higher the RAM, the higher the speed and 
efficiency of the computer. 

Generally two types of RAM are available. For example- 
•	 Static RAM or SRAM (Static RAM) and 
•	 Dynamic RAM or DRAM (Dynamic RAM)

Static RAM (Static RAM or SRAM) 

SRAM is mainly based on bipolar semiconductor technology and each cell of this memory consists 
of 6 transistors. This RAM is very fast and expensive. Because the structure of SRAM is complex and 
the data capacity is small, most computers have a limited amount of SRAM. Usually SRAM is used in 
cache memory. Data is stored in SRAM in a “static” mode, that is, data is stored as long as the power 

Fig. 2.1 RAM
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supply is on, so the SRAM does not need to be refreshed. 

Dynamic RAM (Dynamic RAM or DRAM) 

Usually DRAM is based on capacitors. This type of memory stores information in a “dynamic” 
manner and needs to be recharged at regular intervals to keep the stored information or data intact. In 
this case, like SRAM, when the power supply is stopped, all the stored data is deleted. Naturally DRAM 
is slower than SRAM and DRAM is also relatively cheaper. Most of the computer’s primary memory is 
made up of DRAM. Below are the differences between SRAM and DRAM. 

Difference between SRAM and DRAM: 

SRAM DRAM 
1. �Manufactured using transistor technology. 1. �Manufactured using capacitor technology. 
2. �Information capacity (Storage Capacity) is 

relatively low. 
2. �Information capacity (Storage Capacity) is 

relatively high. 
3. �Speed is relatively high. 3. �Speed is relatively low 
4. �No need to refresh. 4. �To be refreshed at specified time intervals.
5. �Relatively expensive. 5. �The price is relatively low. 
6. �Mainly used in cache memory. 6. �Most of the primary memory consists of 

DRAM. 
Read Only Memory 

Read only memory or ROM is a type of permanent memory where 
previously stored information can only be read (Read) but no new 
information can normally be written. A computer system usually has 
ROM in its primary memory which stores the instructions and code 
necessary to operate the internal workings of the computer. Based 
on circuit technology, this memory relies on logic gates rather than 
electrical charges. Due to this the information stored in ROM is not 
erased even if the power supply is turned off or the computer is turned 
off. That is, the information stored in ROM is permanent and for this 
reason ROM is called non-volatile memory. The data stored in the ROM 
is pre-stored by the ROM manufacturer and cannot be changed by the 
user. These instructions or programs are known as firmware. System 
programs stored in ROM, hardware control programs are examples of 
firmware. Ginbond 

The ROM stores the instructions for the computer to perform predetermined tasks after the power 
supply is turned on and before the user starts working. These functions performed by ROM are: 
1.	 RAM Test (RAM Test): In this process it can be confirmed whether the RAM is working properly 

or not. 
2.	 Power on Self Test (Post): In this method, input devices (keyboard, mouse, disk drive, scanner etc.) 

and output devices (monitor, printer, speakers etc.) are connected to the system and are working 
properly. is done 

Fig. 2.2 ROM
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3.	 All ports are notified that the ROM is activated and working. 
4.	 Booting: The operating system is loaded from secondary storage (hard disk, DVD, CD etc.) into 

RAM to make the computer ready to receive instructions from the user. This process is known as 
booting. 

Types of ROM: 

ROM can be of different types. These are discussed below. 
(a)	 Programmable Read Only Memory: A program can be stored only once in this type of ROM. 

PROMs are convenient and flexible, but cannot store new information and become unusable once 
corrupted. 

(b)	 Erasable Programmable Read Only Memory: It is clear from the name that the data or program 
present in EPROM can be deleted and new data or program can be stored. 

	 EPROM can again be divided into following two parts. 
(1) �Electrically Erasable Programmable Read Only Memory - EEPROM has all the features 

of EPROM. In this type of ROM electric pulses are used instead of ultraviolet light to erase 
information. This type of ROM is usually used where the user’s program is stored in the 
Computer’s primary memory 

(2)	 Erasable Alterable Programmable Read Only Memory - This type of EPROM has the 
advantage of erasing and altering data and does not require the use of any special kind of 
technology. 

(c)	 Ultraviolet Programmable Read Only Memory : This type of ROM is long lasting and very 
expensive. Usually this type of ROM is used in cases where information or instructions need to be 
stored permanently. 

Comparison of RAM and ROM 

RAM ROM
1. �Existing data can be read in RAM and new 

data can be written. 
1. �Information contained in ROM can only be 

read, but not be written. However, data in 
EPROM can be rewritten and this requires 
special programs. 

2. �Data is temporarily stored in RAM. 2. �Information can be permanently stored in 
ROM. 

3. �RAM for loading the operating system and 
other necessary information in the computer 
is used.

3. �ROM is used for Processing required to start 
a computer i.e. RAM Test, Post, Booting etc. 

4 �Data stored in RAM is much faster Access can 
be done.

4. �Data access speed in ROM is relatively low. 
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5. �Any data or program written by the user is 
usually stored in RAM. 

5. �The manufacturer loads the operating system 
into the ROM. 

6. �User can easily load or modify data in RAM. 6. �Changing data in ROM requires expert. 

2.3.2 Secondary/Auxiliary Memory 

Secondary memory or storage is a global storage of the computer where a lot of information and 
graphics can be stored. The new information in this memory is long-lasting, that is, even if the power 
supply to the computer is turned off, the information remains in the secondary memory. Viewing 
information and reading stored information in this memory is very easy. However, data cannot be erased 
if there is no power supply while reading or writing data. Storage of any instruction or data from the 
secondary memory to the computer’s primary memory or RAM and any information or instruction 
from the RAM can be stored here. This secondary memory can be used as an input/output device. 
This memory does not have to be inside the computer and in many cases this memory can end up 
outside the computer. For this reason, secondary memory is also called (external) memory. Instructions 
not currently needed by the CPU are stored in secondary memory. Secondary memory is also called 
auxiliary or buxiliary memory because secondary memory is arranged as an aid to primary memory. In a 
computer system, secondary memory is usually located after primary memory. User can delete old data 
as well as write new data in this memory. Examples of secondary memory are hard disks, floppy disks, 
CDROMs, pen drives, etc. 

Secondary memory can be divided into two parts depending on the different ways of accessing the 
information. Such as Sequential / Serial Access Storage Device or SASD and Direct / Random Access 
Storage Device or DASD. These are described below: 
(1)	 Sequential/Serial Access Storage Device (SASD): In such storage devices, information is 

organized according to specific rooms. So in this case, both learning and reading are done according 
to certain rules. These types of storage devices cannot access data randomly from any location, so 
it takes relatively long time to access specific data. Sided cards, magnetic tapes, cassette tapes etc. 
are such storage devices. 

(2)	 Direct/Random Access Storage Device (DASD): These types of secondary storage devices can be 
accessed from anywhere without any sequence i.e. randomly. This is why it takes much less time 
to access data from direct access storage devices than sequential/serial access storage devices. For 
example, floppy disk, hard disk, CD-ROM, DVD etc. are such type of storage devices. 

	 Direct access storage devices are again of two types. E.g. Magnetic disk and Optical disk. These are 
described below 

	 Magnetic Disk - The magnetic disk is spherical and its two surfaces are usually coated with iron 
oxide. Information is stored in it in the process of magnetization. There are many types of magnetic 
disks, the most notable of which are silent disks and hard disks. 

	 Floppy Disk - Although its use has decreased a lot nowadays, floppy disk was the most used 
secondary storage device. until a few days ago. This type of disk has less capacity but is easy to 
use, cheap and portable. To use. floppy disk a floppy disk drive is attached to the CPU to hold the 
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disk and allows data to be accessed from the disk. Floppy disk is a 
circular disk made of flexible plastic with magnetic oxide coating on 
both sides, the circular disk is placed inside a square plastic jacket 
and the data is stored on this disk by magnetic process. Among the 
different types of floppy disks, 3.5 inch and 2.5 inch disks are widely 
used. Floppy disk storage capacity can be 1.44MB, 2.88MB etc. If 
the magnetic surface of a floppy disk is damaged, the data stored 
on the disk can be erased, but if properly maintained and used, the 
floppy disk will last a long time. 

	 Hard Disk - A high-capacity magnetic disk inside a computer used to store large amounts of data 
is known as a hard disk. Hard disk is one of the main components of computer system. It consists 
of several disks or disks made of metal and coated with magnetic oxide on both sides. Being made 
of metal, these disks are quite hard, hence the name hard disk. Data is stored magnetically on both 
sides of each disk of a hard disk. In a hard disk, the 
disks are connected to a spindle called a shaft. 
Because this shaft is connected to a motor, the hard 
disk can spin freely at high speeds. Each disk has 
one Read/Write head for reading and writing data. 
To protect the hard disk, it is permanently placed 
inside the computer by encasing it in a metal jacket. 
Among the secondary storage devices, hard disk 
has the largest data storage capacity and different storage capacity hard disks are available in the 
market. A 320GB hard disk is sufficient for personal computers, but if more storage capacity is 
needed, another disk can be added. With the advancement of technology, hard disks with terabytes 
or TB storage capacity are now available in the market for storing large amounts of data. The speed 
of hard disk disks can range from 3600 rpm to 7200 rpm (revolution per minute). Hard disks are 
quite expensive due to their high speed and large storage capacity. 

	 Optical Disk - Optical discs are very efficient for storing large amounts of data in a low-cost, small 
volume. Through this type of storage, data is stored and read using laser rays. The most common 
types of optical discs are the Compact Disc or CD and the Digital Versatile Disc or DVD. 

	 Compact Disc or CD - CD is made of Polycarbonate plastic with a thin coating of aluminum on it 
to form a reflective surface. A CD driver or CD player resides in the computer’s CPU cabinet where 
data from the CD is accessed by inserting the CD. However, CD Writer is required to store data on 
CD. Currently there are CD drivers available that can do both Read and Write. When writing data 
to a CD, the laser beam hits specific spots on the reflective 
surface of the spinning disc, creating tiny grooves or holes. 
Presence of such notch or hole is marked by bit “1” and 
absence by bit “0”. A low-intensity laser beam is shone on 
the CD in the CD drive to read the information from the 
CD. The sensor present in the CD drive activates the path 
of light reflected from the reflective surface of the CD. If 

Fig. 2.4 Hard disk

Fig. 2.5: CD

Fig. 2.3 Floppy Disk
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Fig. 2.7 DVD

reflected light is reflected from a flat surface then it is identified as ‘O’ and if it is reflected from a 
notch or hole then it is identified as ‘1’. Typically, CDs have a storage capacity of 700MB or more. 
The types of data that can be stored here are text, sound, video, graphics and graphics animation. 
There are generally two types of CDs available. Such as CD-ROM (Compact Disk Read Only 
Memory or CD-ROM) and CD-RW (Compact Disk Re-Writable). 

	 Information on CD-ROM can only be read. Here information can be written only once, no information 
can be written a second time. CD is the cheapest and most widely used storage medium. 

	 CD Re-Writable is a type of storage medium where data can be written multiple times and then 
erased. That’s why this type of CD is comparatively more expensive. 

	 Digital Versatile Disk (Digital Versatile Disk or DVD) - DVD is now very 
popular as an optical disk with a much larger storage capacity than CD. DVD 
has the same external shape and structure as CD, but DVD has many times 
more storage capacity than CD. The most commonly used type of DVD 
today has a storage capacity of 4.7GB. DVD drivers are required to access 
data from DVDs. A DVD writer is used to write DVDs in the same way as a CD 
writer. 

2.2.3 Cache Memory

In modern computer systems, one type of memory is used in addition to primary and secondary 
memory which differ from primary and secondary memory in terms of storage capacity, cost and speed. 
These are called cache memory. Cache memory is a special type of computer memory that cannot be 
categorized as either primary memory or secondary memory. The storage capacity of this memory is very 
less compared to secondary memory but the data accessing speed is very fast. Cache memory is located 
between the processor and the primary or main memory to increase the speed of processing. In other 
words, this memory balances the performance of CPU and primary memory. Data and instructions that 
are used repeatedly by the CPU are usually stored in cache memory, so that these data and instructions 
do not have to be repeatedly accessed from primary or secondary memory. Since the CPU caches 
information from memory or instructions can be accessed directly and randomly, thereby speeding up 
processing. Cache memory can be of two types. For example, primary cache memory and secondary 
cache memory. The primary cache memory is usually directly integrated with the CPLI. On the other 
hand, certain parts of any disk storage can be used as cache memory if the CPU can directly repeatedly 
access the data and programs stored in that part. This type of cache memory is usually called secondary 
cache memory. 

2.3.4 Units of Computer Memory 

The computer basically deals with the type of data called character. This character can be any 
letter (alphabet), numbers (numbers) or symbols (eg, %, ?,+, etc.). Digital computers work according 
to binary numerology where each character is converted to a binary digit ‘O’ or ‘1’ before processing. 
This binary digit is known as Bit. Bit is the smallest unit of computer memory. That is, any memory. 
And can store as many bits as the memory’s storage capacity. For example, saying the storage capacity 
of a memory is 65,536 bits means that the memory can store a maximum of 65,536 bits (0) or 1). Four 

Fig. 2.6 CD driver
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bits together are called nibbles and eight bits together are called a byte. Saying the storage capacity of 
any memory is 65,536 bytes means that the memory can store a maximum of 65,536x8-5,24,288 bits. A 
larger unit than a byte is a kilobyte. (Kilo Byte) which is equal to 1024 bytes. 

The various units of information or data used in computers are described below. 

1 Nibble =4 Bits 
1 Byte (Byte) =4 Bits (Bits) 
1 kilobyte or 1KB=2” bytes =1024 bytes (Bytes) 
1 megabyte or IMB-2 KB =1024 Kilo bytes 
1 GB or 1GB-20 MB =1024 Mega bytes 
1 Terabyte or 1TB-20 GB =1024 Giga bytes 

Any letter, number or symbol is considered as one byte of data. 

2.4 Software 

Before going into the detailed discussion about the computer operating system, it is necessary to know 
the details about the software. Many instructions or instructions are arranged according to a certain 
rule (logic) to make a program (Program) for performing a particular task by the computer. When these 
programs or instructions are executed by the computer hardware, the required task is completed. This 
form of software consists of one or more programs that are used to accomplish a specific task. For 
example, Microsoft Word is a software used for word processing. Below is the classification of software 
described in tabular form. 

Classification of Software: 

Based on the area of use and function, software can be divided into the following categories- 

Software

Application Software Utility SoftwareSystem Software

2.4.1 Application Software 

Software that is developed to perform a specific task is called application software. Application 
software packages can be of different types, below are the names of some application software and the 
purpose they are used for. 
•	 Word processor software: Word Pad (Word Pad), MS-Word (MS-Word), Word Star (Word Star) etc. 
•	 Spreadsheet software: Lotus 1-2-3 (Lotus 1-2-3), M-S Excel (MS-Excel) etc. 
•	 Database software: MS-Access, Oracle, Foxpro etc. 
•	 Presentation software: MS. Power Point (MS-PowerPoint) 
•	 Desktop publishing (DTP) software: Pagemaker, Corel Draw etc. 

Apart from the above application software, there is a type of application software that is used to 
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perform routine computer tasks and computer maintenance tasks. Such application software is generally 
called utility software. Examples of utility software are antivirus software, backup software, clipboard 
manager, file maintenance software, disk defragmenter etc. Any user can use this utility software as per 
requirement. 

2.4.2 System Software 

The software that manages the computer system properly by controlling all the functions of the 
computer and computer hardware is called system software. This type of software acts as an interface 
between computer hardware and application software. System software is the complex program 
developed by the specialist without whose presence the computer cannot do any work. Different 
operating systems, compilers, translators etc. are examples of system software.

2.5 Programming Language 

The information and instructions required by the computer to perform a task must be given as input 
and these information and instructions must be understandable by the computer system. Otherwise 
performance is not possible. Since the user language is not understood by the computer, so a language 
or sign language is needed to communicate between the computer and the user. Programs are written 
using this language in a set of rules that the computer can understand. This kind of language is called 
computer language or programming language. In other words, programming language or computer 
language is a language through which it is possible to establish a link with a computer machine. For 
every programming language there are some (grammatical or syntactical) and logical (symantical) rules 
are fixed. To write a program using any programming language, the user has to write the program in 
accordance with all the grammatical and logical rules of that programming language. Programming 
languages are of two types, such as low-level languages and high level language. These are described 
below. 
•	 Low-level language - In this language, programs are mainly written using binary bits i.e. only 0 

and 1. Programs written with the help of this language are directly understandable by the computer. 
Assembly language is an example of a low-level language. 

•	 High-Level Language - A language used to write programs in a specific format and in a specific 
format, usually using the English alphabet, is known as a high-level language. This language is not 
directly understandable by the machine, but programs written in high-level languages are more 
understandable to the programmer than to the computer. Because of this, programs written in high-
level languages are converted to machine language to make them understandable to the computer 
before execution. BASIC, FORTRAN, COBOL, LOGO, C, C++ etc. are examples of high-level 
languages. 
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Below is the classification of programming languages shown in tabular form. 

Programming Language

Low-Level Language High-Level Language

Machine Language

Assembly Language

Compiler Based Language

Interpreter Based Language

2.5.1 Translator 

A program written in a high-level language becomes comprehensible to a computer only after 
it is converted into a low-level language or machine language. A translator is software that converts 
programs written in a high-level language into a low-level language. There are two types of translators, 
i.e. interpreters and compilers. 
(a)	 Interpreter - Interpreter converts each line of a program into machine language one by one. 

Although the interpreter takes less time to analyze the source code (program written in high level 
language). Overall program execution speed is relatively low. If there is an error in any line of the 
source. code, the program execution stops at that line. So in this case it is easy to correct errors or 
program debugging. BASIC, Python, Bubi etc. converts a program into code suitable for execution 
on a computer with the help of programming language interpreter. 

(b)	 Compiler - The compiler scans the entire program together to first create an object program and 
then creates an execution program to execute the program. In this case, it takes more time to analyze 
the source code, but overall the speed of program execution is relatively fast. Any errors in the 
source code are reported to the user at the very time the object file is created. So program debugging 
becomes relatively difficult in this case. Compilers are used to execute programs written in CO-
BOL, C, C++ etc. languages. 

2.6 Operating System 

Operating system or OS (Operating System) is a system software that manages the overall 
functioning of the computer by establishing links between different parts of the computer (Hardware) 
and application programs. The operating system creates the environment for using application software 
and provides various facilities for using hardware. Some of the widely used operating systems are Disk 
Operating System (DOS), Windows, Linux, etc. 

An operating system is made up of many pieces of software, each of which performs a specific task. 
As soon as the computer is turned on, the operating system (OS) checks the primary memory (RAM) to 
see how much space is available in RAM and locates the start-up disk (the disk that contains the system 
software) from which the system files are required. by loading into Apart from this, the OS controls the 
functioning of the keyboard, mouse, monitor, printer, etc. included in the computer system. Thus the OS 
waits for the user’s instructions after making the entire computer system suitable for the user’s work. 
How the operating system establishes the connection between the computer hardware and the computer 
user is shown in the diagram below. 
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Computer 
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Fig. 2.8 Internal hierarchy of computer 

2.6.1 Program Execution:

Here the focus is on how a program or task is processed in a computer system with the help of 
the operating system. A task can be executed in different ways depending on the classification and 
capabilities of the operating system. To perform tasks, operating systems generally follow three types 
of procedures. These are serial processing, batch processing and multi programming. These methods 
are detailed below. 

Serial Processing: 

In serial processing, instructions are executed serially. The first instruction given by the system is 
executed first and then the subsequent instructions are executed sequentially. A source program is first 
converted into an object program and then it is loaded into the primary memory of the computer with 
the help of a loader. Then the program starts to be executed and its result is displayed on the computer 
monitor or printed with the help of printer. Once loaded into memory, the program can be executed as 
many times as desired, and the output changes as user input changes. The main problem with serial 
processing is that program execution in this method is very slow and in some cases manual processing 
is superior. 

Batch Processing: 

In this case the tasks required for program execution are first arranged sequentially. Then similar 
tasks are combined into one batch (Batch) and executed. Processing various tasks in batch form allows 
the various parts of the computer system to be used more efficiently. The main problem with this system 
is the speed gap between fast processors and comparatively slow input and output devices. As a result, 
if a task is waiting for input at some stage of execution, the processor sits idle until that input is loaded. 
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Multi Programming: 

Although batch processing can make various parts of the computer more efficient, the CPU remains 
idle during batch preparation. It is never possible for a single user to keep the CPU or input and output 
devices busy all the time. Multi-programming is very useful in this case where it is possible to keep the 
input and output parts of the CPU very busy by running multiple programs simultaneously. In a multi- 
programming system, multiple programs are loaded into the main memory of the computer system. The 
operating system starts to run a program from among these programs. In the case of sequential execution 
(Sequential Execution) the CPU sometimes becomes idle, but in the case of multi- programming the 
CPU can execute other programs. As a result, it is possible to keep the CPU very busy. 

2.6.2 Functions of Operating System 

Operating system is actually a collection of many small pieces of software and each of these pieces 
of software performs a specific task. The tasks performed by the operating system as a whole are 
described below. 

Processor Management 

In the case of multi-programming, the operating system determines how long a program can use 
the processor during execution. Processor management is the most efficient use of the processor during 
program execution. Computers today have multiple co-processors to assist the main processor. E.g. 
Math co-processor (for any mathematical work), graphics co-processor (for graphics work) etc. Proper 
use of these co-processors with the main processor increases the speed of program execution. When 
a task is given to the computer, the operating system divides the task between the processors and co- 
processors and thus completes the task in a much shorter time. 

Memory Management 

The operating system determines how much of the computer’s memory will be used by the system, 
how much will be allocated to user-supplied data or programs, and how it will be used. When multiple 
programs are running simultaneously, how much memory is allocated to which program is called memory 
management. The two main features of memory management are Protection and Sharing. Protection is 
to maintain the necessary distance between each memory address so that multiple. processes do not load 
at the same memory address. Sharing is the sharing of common data by multiple processes. If there is 
an inactive process in the memory, the task of sharing is to remove it and load an active process in that 
part of the memory. 

File Management 

File management is the maintenance of various data and programs stored in secondary memory. 
Operating system file management programs help user programs read, write, or create new files to other 
files. 

Input/Output Management 

With the help of input/output management, the operating system controls the operation of input and 
output devices like keyboard, mouse, monitor, printer etc. The operating system provides commands 
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and assigns specific tasks to various I/O devices. It is also the job of the operating system to correct any 
errors found in the devices. 

Security Management 
This feature of the operating system protects the stored data from intentional or unintentional modification. 
Key Features of Security Management are- 
(1)	 No more than one file or folder with the same name can be created in the same location. 
(2)	 Different files or folders can be protected with the help of password. 
(3)	 Multiple files cannot be created at the same memory address. 

Device Management 

Various devices or devices connected with the computer can be properly used for this feature of the 
operating system. As soon as the computer is turned on, the operating system collects information about 
the components connected to the computer. For example, the operating system recognizes the keyboard 
as an input device and the monitor as an output device. As a result, some peripheral devices cannot be 
opened and a new one installed while the computer is running. After turning off the computer, plug in 
the new device and restart the computer. 

2.6.3 Common Operating Systems 

Currently there are various operating systems available in the market out of which some of the 
popular and widely used operating systems are described below. 

Disk Operating System 

Disk Operating System (DOS) using the tight link between computer hardware and software 
creates an appropriate working environment by providing the user with the facility to use ‘text’ based 
commands. The most common and popular version is Microsoft DOS or MS-DOS, which was developed 
by Microsoft Corporation in 1981 specifically for the IBM-PC. Apart from Microsoft, IBM company 
also developed DOS which is known as PC-DOS. The main functions of DOS are: 
(1)	 Controlling the operation of various application programs when they are used on a computer. 
(2)	 Disk management i.e. making the disk suitable for storing information (eg formatting the disk, 

copying etc.) 
(3)	 Automatic execution or batch processing i.e. helping to automate repetitive tasks through EXE or 

BAT files. 
(4)	 Controlling important functions like Print Management and Resource Management. 

Windows Operating System 

Everything in DOS is done by typing commands, which causes the user to remember a lot of 
instructions and how to use them. This operating system does not have any graphics or picture instructions. 
Due to these reasons the popularity of DOS has decreased a lot. Windows operating system is created by 
removing all these limitations of DOS. The first version of Windows made by Microsoft company was 
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released in 1985. But this version had many limitations. Windows 3.1 was the first successful version 
of Windows in 1992. In 1995, Microsoft launched Windows 95 which gained huge popularity. Later 
versions of Windows are Windows 97, Windows 98, Windows ME, Windows NT, Windows 2000, 
Windows 2003, Windows XP, Windows 7, and Windows 4. The latest version of Windows is Windows 
10. 

Advantages of using Windows are discussed below. 
	 (i)	 Graphical User Interface or GUI: Windows is a GUI so that there is no need to write or remember 

any commands like DOS. Due to the facility of giving instructions, information, etc. through 
images, the necessary work can be completed by clicking the mouse. 

	 (ii)	 Object Linking and Embedding (OLE): With the help of OLE, content from one application 
in Windows can be selectively used in another application and the content can also be linked 
between the two. As a result, any change in one subject automatically changes the other subject. 

	 (ii)	 Advantage of Multi-user: In advanced versions of Windows (Windows NT, Windows XP) 
multiple users can work simultaneously. 

	 (iv)	 Advantage of Multitasking: In Windows operating system a user can complete multiple tasks 
simultaneously. 

	 (v)	 Dynamic Data Exchange (DDE): DDE facilitates data exchange between software running on 
Windows. 

	 (vi)	 Open Database Connectivity (ODBC): Using ODBC on Windows, a database created by an 
application can be created as well as used by other applications. 

	(vii)	 Plug and Play: This feature does not require installing any software separately to add peripherals. 
like CD-drive, monitor, sound card, speakers etc. to the computer. 

Linux Operating System: 

Like Windows, Linux is also a multi user, multi tasking operating system. On the basis of work, 
this operating system can be divided into four layers - kernel (kernel), shell (shell), file structure (file 
structure) and utilities (utilities). Chief among these is the kernel, which runs programs and manages. 
various hardware components. In 1992, Linus Tor released the Vald kernel. A company called GNU adds 
shells, file structures, utilities to the kernel to make it a complete operating system. The shell protects 
the connection with the user. It receives instructions from users and passes the instructions to the kernel. 
File structure determines how files are stored on disk. Initially Linux operating system commands were 
large. Currently using GUI on Linux. The main feature of Linux is that it is an open source operating 
system. Since it is open source, everyone can freely use it and make changes as needed. Since Linux is 
easily available on the Internet and open to all, it usually costs nothing to download it to your machine. 
If you have to buy the Linux CD from the market, the cost is also very low. Linux is much more resistant 
and secure than other operating systems when it comes to virus attacks. 
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2.7 Computer Network 

When two or more autonomous computers are connected to each other through a special medium 
and are able to exchange information with each other, the entire system is called a computer network. 
Computers on a network are autonomous, meaning that one computer can never control another 
computer. In case of network, the communication medium of computers can be cable, optical fiber cable, 
microwave, satellite etc. Computers connected to the network are called nodes (Node) or work stations 
(work stations) and the connection medium is called Communication Channel. Not only computers but 
also other peripherals can be connected to the network system. The advantage of networks is that the 
connected computers can be of different types and capabilities. Information exchanged over a network 
can be written text, words, images, etc. Nodes in a network can use shared software and hardware. But 
the network does not work if the connectivity between them is disrupted. Adequate funds are needed for 
the necessary equipment and maintenance of the network. 

2.7.1 Advantages of Computer Network 

The advantages of computer networks are described below. 

Resource Sharing: Various programs, expensive devices (such as printers, scanners, etc.) and data or 
information can be used by users from all computers located in the network. 

High Reliability: Since important files can be stored on multiple computers in the network, as a result, 
if one computer fails, all those important information can be used from another. That is, because there 
are alternative sources of information, its credibility is high. 

Scalability: Additional processors can be used to maintain or increase the performance and efficiency 
of the network system when the workload increases. As a result, additional work load can be handled. 

Easy Communication: Using the network, two or more people or different organizations can easily 
communicate with each other and exchange information. One can keep in touch with others at any time 
using network services such as e-mail, video conferencing, chatting etc. 

High Security: Information in the network is sufficiently protected. No one can destroy it at will. 
Money Transaction: Using the network, a person can easily perform various bill payments, manage 
bank accounts and investments. At present stock market, computer network is non-operational. 

Home Shopping (Home Shopping): Necessary items can be bought at any time by establishing contact 
with various organizations or companies present in the network. 

Information Collection and Use: Nowadays it is very easy to collect, gain knowledge and use various 
information using the website for various purposes, such as industry, commerce, health, related to 
education, history, science, sports, travel etc. 

Entertainment: The use of network services for entertainment is increasing. Music via internet listening, 
watching movies, playing games etc. is very easy now. 
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2.7.2 Network Architecture 

Based on what type of computers are in a network, what is the purpose of the network, how big is 
the network, whether there is any central control system etc. A Computer networks are divided into two 
main categories - Client-Server Network and Peer-to-Peer Network. These are described below: 

Client-Server Network 

This type of network has a central computer with high efficiency and high storage capacity 
called server. This server is used to control central systems, share hardware and software, and 
protect information. Other less powerful computers or 
workstations on the network are connected to this server 
and are called clients. The user can access the data sent by 
the server only through the client. Client-Server Networks 
are mainly used for data and resource sharing. Almost for 
all the work the required data and software are kept on the 
server. Client computers connected to the server can use 
this data and software. However, permission is required to 
use it and the server has a specific account and password. 
for each client computer. Servers are of different types depending on the function, such as file servers, 
print servers, message servers, database servers, application servers, etc. 

The advantages and disadvantages of client server network are recorded below. 

Benefits: 
	 (i)	 All computers in such a network can access data, programs and printers from the server seamlessly. 
	 (ii)	 In such a network the task of network control and maintenance becomes much easier as the server 

manages the entire network. 
	 (iii)	 The security of this network is strengthened as the control of all important data and software is 

in the hands of the System Administrator. As a result, no computer on the network can change or 
destroy them. 

	 (iv)	 Most client-server networks have special arrangements for backing up servers, and in many cases 
this process is automated. 

	 (v)	 Servers in client server networks have multiple disks, so if one disk fails for any reason, another 
disk can be used. 

	 (vi)	 A client server network can have thousands of users. A peer-to-peer network cannot have such a 
large number of users. 

Disadvantages: 
	 (i)	 In this type of network the whole network is controlled by the server so if the server goes down 

then the whole network goes down. 

	 (ii)	 This network system is complex. Installing the operating system on the server, configuring it for 
each computer on the network, configuring the server programs, setting up security systems-all 
these things take considerable time and effort. 

Fig. 2.9 Client Server Network
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Peer to Peer Network 

The main characteristic of this type of network is that there are no servers and every computer 
in the network has equal importance and responsibility. Each computer can act as a server and client 
simultaneously. If one computer is allowed to share the data on disk, other computers can use that data 
or exchange data. The advantages and disadvantages of such networks are recorded below. 

Benefits: 

	 (i)	 The structure of this network is very simple and straightforward. 

	 (ii)	 No servers are required in such networks and there is no need to install any software separately or 
configure them for the network. So there is no need for System Administrator. 

Disadvantages: 
	 (i)	 Peer to peer network has no central control system. 
	 (ii)	 Data security measures are almost non-existent in such networks. 
	 (iii)	 Peer-to-peer network has no provision of data backup for entire network. As a result, each computer 

needs to be backed up separately. 
	 (iv)	 Such networks are not ideal for long distances. 
	 (v)	 Large number of users cannot be connected to such network. 

2.7.3 Network Topology 

In order to exchange information between computers and other devices 
on a network, they must first be connected to each other. The geometric 
arrangement of how computers and other devices are connected in a network 
is called network topology. 

Network topology can be of the following types. For example: 

•	 Bus Topology 

•	 Star Topology 

•	 Ring Topology 

•	 Mesh Topology and 

•	 Tree Topology 

The components required for different topologies are also different. Also, the method of exchanging 
data through the network is different for different topologies. So selection of proper topology for any 
network is very important. 

•  Bus Topology 

Bus topology is the simplest topology. In this case the computers are connected with a main 
cable. This main cable is called trunk or backbone. In this topology, data is sent from one computer to 

Fig. 2.10 Network 
Topology
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another computer’s address through electronic signals. As 
this signal passes through the trunk, the data goes to the 
computer whose address matches the data’s address. In bus 
topology only one computer can send data at a time. So 
when one computer starts sending data, other computers 
have to wait. As the number of computers in the network 
increases, the amount of this queue increases, resulting 
in delays in sending data. In bus topology, even if one 
computer goes down, there is no problem in sending data 
to other computers. But if one part of the trunk goes bad, 
all the computers on the network after that part become 
isolated from the previous computers. The bus cable alone connects all the nodes, so this topology 
requires short cable lengths. Although the bus topology is simple, fault finding is very difficult. 

• Star Topology 

In star topology computers are connected to each other through a network device. 
This central device is called a hub. The hub controls the network here. Figure 2.12: 
Star Topology The signal from the computer sending the data first arrives at the hub 
and then from the hub to the other computers. An advantage of star topology is that 
data exchange is centrally controlled through hubs. This is also inconvenient because 
if the hub is down, the entire network goes down. However, like bus topology, the 
network works even if one of the computers goes bad. Additional computers can be 
added in a star topology. A hub can typically accommodate 4, 16 or 32 computers. 
If you want to connect more. computers than this, you have to connect another hub 
with the hub. A second hub can accommodate many more computers. In this way the network can be 
extended by installing multiple hubs. 

• Ring Topology 

In a ring topology, computers are connected to each other in a circle. There 
is no such thing as a circular bus topology. There are no free ends. A signal sent 
from one of the computers in this topology. It goes through every computer on 
the network. As a result, each computer has control over the signal. After a signal 
arrives at one computer, if that computer releases the signal, it can pass to the next 
computer. with each device located within the ring. One repeater is connected. 
If a computer receives a signal and finds that the signal is not for that device, 
the repeater associated with that device amplifies the weak signal and sends it 
to the next computer. Ring topology is much easier to deploy than other topologies. This is because 
each device is connected to its neighboring devices to make any changes to the network type, only two 
connections need to be changed. The disadvantage of ring topology is that if one computer goes down, 
the entire network goes down. 

Fig. 2.12 Star 
Topology

Fig. 2.13 Ring 
Topology

Fig. 2.11 Bus Topology
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• Mesh Topology 

In a mesh topology, each computer is separated from every other computer 
by a cable are connected separately. Mesh topology is most reliable for data 
exchange. From a computer to which data is to be sent, the data can go directly 
to that computer or through another computer to that computer. The advantage 
here is that since one computer is connected to another computer in all possible 
ways, even if one of them is disconnected, the data can reach the correct address 
in the other way. The main disadvantage of this type of topology is the number 
of wires and I/O ports the number is much higher. As the number of computers 
increases, the number of cables increases exponentially. So creating such a 
topology becomes very complicated if the number of computers is very large or if the computers are 
spread over different places. Deploying such a topology is very expensive. 

• Tree Topology 

As the name implies, nodes are located at several levels in a tree topology. The first layer consists 
of the main computer which plays the role of server. Client nodes are connected via cables to the host 
computer at the next level. Again the branch nodes of those 
nodes are located at the next level which are connected to 
that node through cables. Thus one level node acts as the 
‘parent’ of the next level node. In this type of topology, each 
node has direct or indirect communication with the main 
computer and nodes at different levels. This network is 
also called Hierarchical network. Tree network topologies 
can span relatively large distances. In this case network 
expansion is easier because such networks are divided into 
sub-branches. Fault detection and correction is easier in this 
type of network because it is easy to isolate one or more nodes from the main structure. The main 
disadvantage of this topology is that if the main computer fails, the entire network becomes useless. The 
structure of this type of network is relatively complex and so is the speed of data flow. 

2.7.4 Types of Computer Network 

There are mainly two types of computer network based on geographical location. For example- 
•	 Local Area Network (LAN) and 
•	 Wide Area Network (WAN) 

There are also Metropolitan Area Networks (MANS) which are actually larger versions of LANs. 

•   Local Area Network (LAN)

Server LAN is the backbone of any computer network. A network system organized by a relatively 
small number of different types of computer systems (computers and peripheral devices such as printers, 
modems, etc.) located geographically at a short distance and exchanging information through wires or 
cables is called a local area network or LAN. LAN distance is a consideration because computers are 

Fig. 2.14 Mesh 
Topology

Fig. 2.15 Tree topology
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usually connected via cables. The span of LAN is usually from 
10 meters. is within kilometers. All computers in an organization 
or all computers within an apartment building, or even all 
computers in multiple apartment buildings side by side, can be 
connected using a LAN. Generally Co-axial cable is used in 
LAN. Generally LAN speed i.e. data transmission rate is 10-100 
Mbps (Mega bits per second). Computers connected to a LAN 
are connected through various network topologies (Bus, Ring, 
Star etc.). The main advantages of LAN are that the structure 
of the network is simple and easy, the cost of construction and 
maintenance is low, and users can share all computers and 
peripherals (such as printers, hard disks, modems, etc.). 

•   Metropolitan Area Network (MAN)

MAN is a larger version of LAN. A network formed by 
connecting different edge computer systems. located within 
a large city is called a MAN. So a MAN is a combination of 
multiple LANS located in the same city. Here too generally the 
same technology as LAN is used. MAN can span up to 10-20 km 
and its data transmission speed is lower than LAN. Computers 
are connected in MAN by coaxial cable, fiber optic cable etc. 
The structure of MAN is more complex than LAN and the cost 
of data transport is also higher. 

•   Wide Area Network (WAN)

Such network systems span over wide areas. Indeed 
geographically distant LANS or MANS are connected 
together to form the resulting network system WAN. Such 
networks may span a country or a continent. Distance is 
naturally a major consideration here. Hence the medium 
of communication also varies and in many cases multiple 
mediums are used. In most cases telephone lines and 
microwave and satellite communication systems are used 
for WAN. In addition, undersea leaf cable lines are also used. 
WAN is the only way to protect the communication between 
the whole world. The Internet is the most prominent example of a WAN. In WAN cost in comparison 
with the efficiency and the advantages. obtained from the network is low. 

Fig. 2.17 MAN

Fig. 2.18 WAN

Fig. 2.16 LAN



34

2.8 Summary
•	 This chapter discusses in detail about computer memory, operating system and computer network. 
•	 Data and programs are stored in computer memory. Generally memory is of two types primary and 

secondary. Primary memory is the real brain of the computer without which the computer cannot 
function. Primary memory has two parts - temporary memory or RAM and permanent memory or 
ROM. A lot of information and programs can be stored in the secondary memory of the computer 
for a long time. Again data can be deleted from here very easily. Hard disk, floppy disk, CD-ROM, 
DVD etc. are known secondary memories. The smallest unit of computer memory is BIT or Binary 
Digit 

•	 A computer operating system is the system software that controls the overall functioning of the 
computer. Without an operating system, no work can be done with computer hardware or programs. 
The operating system controls the hardware and creates the execution environment. DOS, 
WINDOWS and LINUX are three widely used operating systems. 

•	 A computer network is a system of connections through which two or more computers exchange 
information and share resources with each other. The computers in the network are called nodes or 
workstations and the connection medium is called the communication channel. 

•	 According to the architecture of the network, computer networks are of two types: client-server 
network and peer-to-peer network. 

•	 Topology is the geometric arrangement of computers and other devices in any network. Common 
network topologies are bus topology, star topology, ring topology, mesh topology, and tree topology. 

•	 Computer networks are of three types based on the size of the network. These are Local Area 
Network (LAN), Metropolitan Area Network (MAN) and Wide Area Network (WAN). Computers 
located at short distances is connected via LAN. Generally computers in different locations in a big 
city are connected through MAN. WAN expansion is global. The best example of a WAN is the 
Internet . 

2.9 Unit End Exercise 
	 (1)	 What is computer memory used for? 
	 (2)	 What is RAM ROM? 
	 (3)	 How many types of ROM and what are they? 
	 (4)	 What is the need to use secondary memory in a computer? 
	 (5)	 Why is RAM called temporary memory? 
	 (6)	 What does booting mean? 
	 (7)	 Describe a hard disk with pictures. 
	 (8)	 What does Cache Memory mean? What is this memory used for? 
	 (9)	 What does Software Hardware mean? 
	(10)	 What is Utility Software? 
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	(11)	 What is programming language? 
	(12)	 What is operating system? 
	(13)	 What is meant by serial processing and batch processing? 
	(14)	 Describe the functions of operating system. 
	(15)	 Write the advantages and disadvantages of computer network. 
	(16)	 What are the network requirements? 
	(17)	 What is network topology? Describe various network topologies with pictures. 
	(18)	 Describe LAN, MAN and WAN with pictures. Write down their advantages and disadvantages. 
	(19)	 Write the difference: 
		  RAM & ROM, CD & DVD, System Software and Application Software, Compilers and 

Interpreters, Client-Server and Peer-to-Peer Networks, LAN and WAN 
	(20)	 Write short Note on: 
		  Primary Memory, ROM, Hard Disk, CD-ROM, Application Software, Multi Programming, 

Secondary Storage, Linux, Star Topology, MAN, Computer Language. 
	(21)	 Write full name: 
		  RAM, ROM, EEPROM, UVPROM, POST, SASD, CD-ROM, DRAM, DVD, GUI, LAN, WANI 

Project Work 
	 (1)	 Identify the different parts of the computer used in the computer lab. 
	 (2)	 What type of computer network is present in your computer lab? Give reasons in favor of the 

answer. 
	 (3)	 Create folders in WINDOWS Desktop according to the structure below. 

SCERT
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UNIT
3

Word Processing System in Computer 

3.1 Introduction

3.2 Objectives of the Unit 

3.3 Some General Characteristics of Word Processing

3.4 Working with MS Word

3.5 Page Setup

3.6 Inserting Table

3.7 Chart Preparation

3.8. Printing a Document

3.9 Some Essential Keyboard Shortcuts Used in MS Word

3.10 Summary

3.11 Unit End Exercise

3.1 Introduction

The softwares which provides all the facilities (like cut, copy, paste etc) of text editing or processing 
and convert text into various formats are known as word processing software or word processing package. 
In short all the facilities required to create a document or report are available in a word processing 
software. There are various word processing packages are available in the market out of which the most 
used word processing package is Microsoft word or MS word which is a part of MS Office. MS word is 
a application software using which one can create a document by text writing, text formatting, sharing 
and printing. 

Different types of word processors are available in the market out of which popular word processors 
are Star, World perfect and Microsoft word. 

3.2 Objectives 

After reading of this unit learners will be able to - 
•	 Acquire the knowledge of word processor and word processing.
•	 Describe the general features of word processing in a computer. 
•	 Describe what is mail merge and how to use it. 
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•	 Create various documents, editing and printing of a document and storing it for future use, etc. 

3.3 Some General Characteristics of Word Processing

Word processing program provides all sort of activities to create a document into a computer. In 
other words a document can be created efficiently in the computer using a word processing program. 
General characteristics of a word processing program can be classified into different categories such 
as basic features, desktop publishing features, language features and web features. These features are 
described in detail below - 

Basic features: 

Writing of text and editing of text can easily be done using this feature of word processing. The 
facilities. provided by the basic features of word processing to create a document are 
•	 Sharing of document to use in future 
•	 Saving of document in different formats to use it in different medium such as RTF (Rich Text 

Format), PDF, HTML, etc. 
•	 Insertion of new text or deletion of text in a document. 
•	 Searching of text and replacing of text in a document. 
•	 Copy of text document and shifting of the document from one place to another. 
•	 Word wrap around that is automatically shifting of cursor from end of a line to the next lower line 

in a document without pressing enter or return. 

Desktop publishing features :

Arranging of document, report, newsletter, handout etc can be done very beautifully using desktop 
publishing features of word processing. The facilities provided in these features of word processing are 
described as below–
•	 Provide the alignment and justify facility 
•	 Provide the facility to use fonts, style, colour, margin, line spacing etc of text in a document. 
•	 Provide the insertion facility of header, footer and page number in a document. 
•	 Provide the facility of insertion of picture, graph, chart etc in a document. 

Language Features: 

This features help to apply proper grammar. The facilities provided in these features are described 
as below - 
•	 Spelling check and correction of every word in a document. 
•	 Use of alternative words or synonyms in a document 
•	 Provide help to apply appropriate language and proper grammar in writing a document. 

Web Features: 
With these features of word processing award document can be connected to the internet. The 

advantages provided by these features of word processing in creating a word document are described 
as below- 
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•	 Helps to insert a live URLs into a document so that the document can be linked with the internet and 
web resources can be used within the document. 

•	 Helps to create the web pages. 

3.4 Working with MS Word

To create a document by opening MS word, the following steps are to be followed - 
•	 Click on the start button in the windows 
•	 Select programs from the menu appears 

Fig. 3.1 Opening MS Word
•	 From the list of application programs that will appear, bring the mouse pointer on Microsoft word 

and click once to open the Microsoft word window or page. Now on these page you can create 
documents as needed. However, to create a document using MS word, you first need to know about 
MS word window. It is described below 

3.4.1 Introduction to Word Window:

Before working with a document, it is necessary to know the screen of Microsoft word properly. 
Components appearing on these page are discussed below - 

Fig. 3.2 MS Word Window
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•	 Title bar - the name of a document along with the text “Microsoft Word” is displayed in this bar. 
•	 Menu bar - with the help of this bar different commands can be used by opening different menus 

and the necessary functions can be completed. 
•	 Toolbar - using this bar various commands under special groups can be used. 
•	 Vertical scroll bar - with the help of this bar one can move upward or downward of the document. 
•	 Horizontal scroll bar - using this bar one can move towards the left or right of a document. 
•	 Split bar - using this bar the word window can be divided into two or more parts so that the various 

portions of the document can be viewed simultaneously. 
•	 Status bar - various information of a document such as total number of pages, current page number, 

cursive position etc. are shown in this bar. 
•	 Next Page & Previous Page - clicking on this one can move to the next page or previous page of 

the document accordingly. 
•	 View button - it helps to present a document in various forms (such as normal, web layout, print 

layout, outline etc). 

3.4.2 Creating a New Document

To create a new document using MS word the following steps are to be followed --- 

	 1.	 Click on the button file menu. 

	 2.	 Dialogue box will appear as shown below and click on blank document icon from the digital box.

	 3.	 Finally click on okay button and a new document will be created. Now it is required to type the 
content or text. 

File → New → Open a dialog box → Blank document 

Fig. 3.3 Creating a New Document



40

3.4.3 Saving a Document 

New document or file must be saved after finishing the job. Otherwise the new document will be 
deleted as soon as the computer is shutdown. In this case both the options save and save as are basically 
used to save the / document. With option save, a document can only be saved to a specific location on 
the computer. On the other hand, a document can be saved to different locations (such as desktop, C 
drive, D drive etc.) On the computer by the option save as. First clicking on file menu select save or save 
as dialogue box and save the file or document by providing the name of it. File or document can also 
be saved with the help of the keyboard. In that case pressing Ctrl + S or F12 will open save or save as 
dialogue box respectively. The procedure to save a document is shown as below - 

File → Save/Save As → Chooses the location/Default location →  
Put a file or Document name → Save 

Fig.3.4 Document Saving
After saving a document in MS word the extension of the file or document will be doc or docx. 

3.4.4. Opening a Document

To read or edit any document, the document is to be open first. To open a file or a document select 
open from file option and then click on the file name from its own location. With the help of keyboard 
press Ctrl+O to open a document. The procedure to open a document is shown as below - 
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File → open → Select the drive name (location) → Select the file 
name which we want to open → Open

Fig. 3.5 Opening a Document

3.4.5. Editing a Document 

If something needs to be changed after creating a document, then something new can be added to 
the content of the document or some portion of the content can be deleted from the document. In this 
way the content of the document can be changed by inserting or deleting new text. In addition, some 
portion of the content of the document can be replaced and new text can be added. This process are 
called document editing. Various options for editing a document in MS word are discussed below–

•	 Copying :

	 It is possible to copy a part of a file or a document from one place to another. The part to be copied 
can be copied by selecting the part with the help of editing bar or by pressing Ctrl+C button on 
the keyboard. Now the selected part will be copied to the specified position of the document after 
placing the cursor to the specified position and using editing bar or by pressing Ctrl+V button from 
the keyboard. It is also possible to copy the selected part into another document. 

•	 Pasting :

	 It is possible to cut or copy some part of a file or document and paste it to another location or in 
another document. This can be done with the editing bar or by pressing Ctrl+V button from the 
keyboard. 

•	 Deleting :

	 It is possible to delete or clear an unneeded part of a document. This can be done by pressing the 
delete key or backspace key from the keyboard. 
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•	 Subscript and Superscript :

	 During writing many times it has to be written a letter or a number below or above another letter. 
The letter written below is called Subscript and the letter written above is called Superscript. 
For example in A2 or A3, 2 is called Subscript and 3 is called superscript. To write a subscript or 
superscript in a document, first click on the home menu of the page and then click on the font and 
finally click on subscript (X2 or Superscript X2. Then click ok and type 2 in the document. Then 
again go to font option in home menu and click on subscript or superscript command to unselect the 
option. Alternatively press Ctrl+ = for Subscript or Ctrl+Shift+ = for superscript on the keyboard to 
write subscript or superscript quickly. 

•	 Change Case: 

	 Changing the words within a line to lowercase or uppercase is called change case. To do this, first 
select the word of the line or the total line and then select change case from the home tab. Change 
Case dialogue box will appear and click on change case in the dialogue box. You can also press 
Shift+F3 as a shortcut to change the case. 

•	 Changing of Font, Style and Size : 

	 If you want to change font, font style or size of the font in a document, then first select the text and 
click on the font part of home tab then go to the font dialogue box option and select the desired font 
and click ok. The shortcut key to open the font dialogue box is Ctrl+D. 

Fig. 3.6 Changing of Font, Style and Size

•	 Spelling and Grammar: 
	 Sometime the content of a document may contain misspelling or grammatical errors. MS word has 

options to find and fix such mistakes. In this case, if the spelling of the word is wrong a red dotted 
line can be seen under the word and if there is grammatical error, a green dotted line can be seen 
under it. For red underlined word if we right click on the word a window will open. In this window 
there will be many words similar to that spelling and user will click on the word that he/she likes 
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and that word will be inserted into the document. Many times it can be seen that read underline will 
appear under the words which are not available in the dictionary of the computer. In that case read 
underline will disappear on clicking the option ignore or ignore all. 

Fig. 3.7 Spelling and Grammar

•	 Clip Art: 
	 If it is needed to insert any image from clip art into a document, then follow the steps below - 

a.	 The document in which the image is to be inserted from clipart, must be open first. 
b.	 Place the mouse pointer at the place where the clip art is to be inserted. 
c.	 Click the clipart button in the illustration command group of the insert tab. 
d.	 The clipart task pane window will appear. 
e.	 Enter the required type of clipart or graphics in the search for option of the task pane and click 

on go all to find the required graphics. 
f.	 Next click on the desired picture or graphics, the clipart will be inserted in the specified place 

of the document. 
•	 Symbol : 
	 Sometimes documents required special characters or symbol that are not normally available in 

the keyboard. MS word as facility to insert such symbols. These symbols can be inserted in the 
following ways. Place the cursor where the symbol needs to be placed in the document and click to 
insert. Then click the close button to close the window. 

Insert → Symbol → Select the symbol → Insert 

•	 Word Art: 
	 Any word or text can be written in different styles with the help of insert word art option of the 

drawing tool. This task can be done as follows. 
a.	 Click on Word Art button from insert tab. 
b.	 Various styles of word art can be seen on the screen. Select the desired style. 
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Fig. 3.8 Word Art

c.	 Text box of edit word art will appear on the screen. 
d.	 Type the required text in the text box. Desired font and font size can also be selected from the 

text box. 
e.	 If required change the text to bold or italic style. 
f.	 Finally click on ok button. 

•	 Mail Merge : 
	 If you want to send the same document or later to different addresses, write the content or body of 

the letter as main document and all the addresses as another document (called data source), Merge 
these two documents together with the help of merge option is called Mail Merge. 

	 The entire mail merge process is basically done in three stages, namely - 
a.	 Create main document 
b.	 Create data source 
c.	 Merging of main document with the data source. 

	 The following steps are to be followed to make the entire process very simple and orderly. This is 
to remember that the mail merge task should be open before the starting of mail merge and click the 
start mail merge button and also follow the step by step mail merge options. 

•	 Create/ set up main document: 
a.	 Click on mailing ribbon and then click the start mail merge button from the start mail merge 

group. A least will appear from which the letter option is to be selected. 
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Fig. 3.9 Create/ set up main document

b.	 Then type the body of the letter. A sample is shown below - 

	 To 
	 Dear X,

	 Cordially invited to attend my birthday celebration party which is to be held on 20th August 
2018 Tuesday in my own house. 

	 I wish that you must come to my house in Salt Lake at 8:00 p.m. onwards. 

Your loving friend 
Y 

•	 Creating data source: 
	 Create data source the following process is to be followed: 

a.	 Click on select recipes button and then also to click type a new list again. 
b.	 New address list dialogue box will appear in this dialogue box, the field names like title first 

name, last name etc will be in separate columns. Looking on the customise columns button will 
display the customise. Address list dialogue box to remove the undesired fields while keeping 
the desired fields. Fields 

c.	 To delete additional fields select these field and click on the delete button. To add a new field, 
click the add button in the customise address list dialogue box. An add field dialogue box will 
appear. Enter the name of the field and click on the ok button. 

d.	 Then click ok button in the customise address list dialogue box. 
e.	 The new address list dialogue box will appear. Hence the specified fields have to be filled with 

correct information. Once all the information of the first recipient is entered, click on the new 
entry button to enter the information of the next recipient. In this way after the entry of all 
records click on ok button.  
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f.	 Then the save address list dialogue box will appear. All recipient records typed here will be 
stored as a file. Now type the desired file name in the text box of this dialogue box and click the 
save button. Note that the .mdb extension will automatically appeneded to the data source file 
containing the recipient’s address. 

Fig. 3.10 Creating data source

•	 Merging main document and data source: 
	 At this stage, merging the data source with the main document will complete the mail merge process. 

a.	 First, open the main document then put the cursor under the text ‘To’ of main document and 
click on the insert merge field button to add various fields from the list (such as first name, 
address line 1 etc) to the main document. 

Fig 3.11 Mail Merge

b.	 Then click on preview results button 
c.	 By clicking on the arrow symbol of the next record the records of each recipient can be seen.
d.	 Then click on finish and merge button in the finish command group and click on print document 

in the list. Merge to print a dialogue box will be displayed. Click the Ok button in the dialogue 
box to print the document. 
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Fig. 3.12 Creating data source

3.5 Page Setup

The page layout option can be divided into several sections. For example, margins, vertical 
alignment, page and paragraph break, section break, page number, header and footer,paper size etc. 
These are highlighted below—
a)	 Margins: margins can be set up on that page by using the specific page from the page layout tab 

located within the page setup command group. The margin values of a document can also be changed 
according to users’ needs from the page setup dialogue box. All the options that are available in the 
margin tab property sheet situated in the page setup dialogue box are top or top margin, bottom or 
bottom margin, left or left margin and right or right margin. Besides these Gutter is used to provide 
margin or extra space and its position is determined for book binding. 

b)	 Orientation: Any page can be set in two different orientations such as portrait and landscape. Portrait 
is used for setting the page vertically and landscape is used for arranging the page horizontally. 

c)	 Multiple pages: Multiple pages list box is available after orientation option in margin tab sheet by 
which some page setup property can be used in multiple pages according to the user’s choice.

Fig. 3.13 Page setup
d)	 paper size: To change the size of a certain paper the typed text must be selected first. The options 

available after clicking on the paper tab property sheet in the page setup dialogue box are discussed 
below—
•	 Paper size list box : The size or shape of the paper is defined with the help of the paper size list 

box. For example A1, A2, A4, letter, legal,A3, A5 custom etc. 
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•	 Width : This section is used to determine how wide a particular page or paper will be. 
•	 Height: This field is used to define the height of a particular page 

Fig. 3.14 Page setup
•	 Paper source: The paper source option is said by two different scroll boxes in the paper size 

tab property sheet located in the page setup dialogue box to print one or more pages. These two 
options are first page scroll box and other pages scroll box 

e)	 Page and Paragraph Break: If you want to start a new page with a break after a paragraph specified 
by the user for his specific page, the page break located in the page command group of the insert tab 
is to be clicked on. The position from which the page break should be done, is the position where 
the user has to keep the cursor in the page,the page will be split into two and a new page will start 
from the part. 

f)	 Header and Footer : Clicking on header button from header and footer command group in the 
insert tab, A header gallery list will be displayed. The header title of the file can be set by writing the 
title or header of the document file according to the users choice. Header and footer tool are called 
design tools. The footer area has the Buttom of a particular page is associated by the go to footer 
button located within that design tab. Also if you Mark the footer button from the header footer 
comment group gallery will open in which page number document file name, date etc. Can be set 
according to the users wishes. With the help of the header footer design tab, after completing the 
specified work of header footer, clicking on close button will close the header footer. 

Fig. 3.15 Header and Footer
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g)	 Page number: To assign page numbers to the pages of a document select header footer comment 
group from the insert tab and click on the page number option. Hindi substance the user can write 
the page number one the page margin. Also clicking the format page number from the drop down 
menu in the header footer comment. group of the design tab will display the page number format 
dialogue box any of the page number for maths from the number format scroll box and also select 
the page numbering start radio button. That from which the page number will start in the document 
and click ok button of multiple pages of the document namely 1-2-3... 

Fig. 3.16 Page number format box

h)	 Section Break: To create two or more columns or sections on a page, if any one of the column 
drop down boxes located in the page setup command group under the page layout Tab is marked 
according to the user’s choice and ok, a text can be written or typed according to multiple columns 
on specific pages. Also column break option can be found by clicking on the insert page and section 
break rectangular box located at the top right of the page setup comment group on the page layout 
tab. 

Fig. 3.17 Column Dialogue box
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3.6 Inserting Table

If you need to insert a table in a document you can create 
a table from the table grid option located in the insert tab of 
the MS Word menu bar. Below are the method for greeting 
tables written the document. 

Creating table with the help of mouse:

Move the mouse pointer to the part of the document 
where the table is to be inserted and click. After clicking on 
the table group located in the insert tab, the table grid option 
will appear. From the option then row and column number 
of the specified table mark according to the users choice and 
neat, and click with the mouse with reach the specified parts 
of the table document. 

Creating table with the table option:

Making an clicking the table option from the table group comment located in the insert tab will open 
the table dialogue box in which the number of rows and columns can be determined according to the 
requirement and after clicking the okay comment button, the table with the specified rolls and columns 
will come to the document file. 

Fig. 3.19 Creating table with the table option

Marching and splitting is the process of combining multiple cells in a table first identify the sales 
to be March. By selecting the Marked sales and clicking the March option in the March sales comment 
group located in the layout contextual tab, multiple cells will be March into one cell. To divide a sale in 
a table into multiple parts, after identifying the specific sale in the table click the speed cell option of the 
March comment group located in the contextual tab, a dialogue box will appear in feet the number of 
parts that the subject cell will be divided into is determined. After clicking the okay button the cell will 
be divided according to the specified number.

Fig. 3.18 Inserting Table
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3.7 Chart Preparation

It is possible to insert graphs or charts into 
a document as needed. The insert chart dialogue 
box will appear if you place the cursor in the 
part of the document file where the chart is to 
be inserted and click the chart option in the 
illustration command group located in the insert 
tab. In that dialogue box mark any chart located 
in the template as needed and click the ok 
command button to bring up the specific chart. 

It is also possible to create charts or graphs 
based on the data or information in a specific 
table in the document. To accomplish the task, 
the table located in the document must be 
selected first. The data sheet for the First row of 
the selected table should be labelled with the specified name as the X-axis (along the horizontal axis )
and the left most column of that table should be labeled as the y axis (along the vertical axis). After 
selecting the specific chart or graph from the chart dialogue box and clicking the okay button, the chart 
or graph will move to a specific place in the document according to the data sheet of that table. 

Fig. 3.21 Chart Preparation according to the data

3.8. Printing a Document

To print a word document, select the print option from the options available by clicking on the file 
button. In this case, the user can change the required options from the dialogue box that opens. For 
example - printer name, which pages to print or all pages to print etc. Finally if you click ok, the page 
or document will be printed. The shortcut key to print a document is Ctrl + p. 

Fig. 3.20 Chart Preparation
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Fig. 3.22 Document Printing

Before printing, you can see how a document will look when printed through print preview. Shortcut 
key to view print preview of document is ctrl+ F2. Print can be possible from print preview also. To 
back from the print preview close button must be pressed. 

Fig. 3.23 Print preview

3.9 Some Essential Keyboard Shortcuts Used in MS Word
Shortcut key Use 
Home To move the cursor at the beginning of the current line. 
End. To move the cursor at the end of the current line 
Page up Page down To move the cursor of a screen 
Ctrl + home To move the cursor or down a screen 
Ctrl + end To move at the very beginning of a document. 
Ctrl + page up Move to very end of a document 
Ctrl + page down To move at the first character of the current screen 
Ctrl + To move at the last character of the current screen 
Ctrl + To move one word to the right 
Ctrl + To move one word to the left 
Ctrl + To move at the beginning of previous paragraph 
Ctrl + C To move at the begning of next paragraph.
Ctrl + X To Copy To Cut 
Ctrl + V To Paste 
Ctrl + P To Print 
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3.10 Summary
•	 Word processing is the process of expressing word in a comment and orderly manner through a 

computer. 
•	 Important features of word processing are creating new document, saving copy editing etc. 
•	 MS Word of Microsoft office is an important word processing tool. 
•	 It is possible to add header and footer to the word document and use symbols, bullets numbers etc. 

as needed 
•	 Word Art, subscript and superscript can be used to style the document content of various images can 

be inserted through Clipart. 
•	 Mail merge method is used to send letters of some content to different addresses.  

3.11 Unit End Exercise 
1)	 How to open MS Word? 
2)	 How a document is saved? 
3)	 Describe how H2SO4 can be written? 
4)	 Write how Clipart is used in a MS Word document? 
5)	 What is header/footer? How to add header/ footer in MS Word? 
6)	 Discuss how tables are created in MS Word with examples. 
7)	 Write the steps on how to print a document? 
8)	 Explain mail merge procedure in detail ?
9)	 Write the differences.
	  i) Save & Save As.
	 ii) Copy and cut.

Project work:
1)	 Write 10 sentence paragraphs about your organization and apply the following formatting to the 

paragraph like Bolt, Italic, underline, Centre alignment, different line spacing option and Indentation. 
2)	 Create a table with five columns and 4 rows and feel it up with data. 
3)	 Prepare D. El. Ed course certificate. 
4)	 Prepare an application for the post of Para teachers in 5 different schools using mail merge.
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UNIT
4

MS Excel

4.1 Introduction

4.2 Objectives of the Unit

4.3 Worksheet

4.4 Data Editing

4.5 Working with Workbook

4.6 Data Handling

4.7. Uses of Chart and Graph in Excel Sheet

4.8 Printing Worksheet

4.9 Use of Formula in Ms Excel

4.10 Functions of MS Excel

4.11 Summary

4.12 Unit End Exercise

4.1 Introduction 

A spreadsheet program is an application software, where data is arranged along rows and columns, 
mainly to perform various mathematical operations. An important case tool in the MS Office package 
is Microsoft Excel or MS-Excel which is a powerful spreadsheet software that can be used to perform 
various mathematical tasks quickly and easily. Also, with the help of Excel, data management, graph 
drawing etc. can be done efficiently. 

A file created in Excel is called a workbook. A workbook contains multiple worksheets. Data can be 
inserted into MS Excel through a Work sheet and analyzed through various methods. Below are the 
steps to be followed to work in MS-Excel 
•	 Click on Windows Start button. 
•	 Select All Programs from the menu that will appear. 
•	 Select Microsoft Office from the list of programs that will appear. 
•	 A blank Excel work-book will open. Here the user can complete the task as per his requirement. 

Start -> All Programs -> Microsoft Office -> Microsoft Office Excel 
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4.2 Objectives of the Unit
After reading of this unit learners will be able to:
1)	 Describe worksheet & workbook
2)	 Enter different types of data into Worksheet
3)	 Create different types of Graphs & Charts into Worksheet
4)	 Apply various formulas for numerical data processing

4.3 Worksheet 

As soon as you open Ms Excel the Excel Workbook named Book1 is visible which contains three 
worksheets by default. New worksheets can be added as needed. A brief introduction to the various 
sections of the Workbook is given below. 

Microsoft Office Button: The rounded Microsoft Office Button is available in the upper-left corner 
of the Excel 2007 Workbook window. On clicking this button, one can complete the various important 
tasks such as create a new file, open and close an old file, save a file, print a worksheet, send attachments 
by e-mail, exit from Excel, etc. 

Quick Access Tool bar: This Tool bar is situated at very right next to the Microsoft Office Button 
and contains the icons of frequently used commands such as Save, Undo, Redo etc. Various tasks can 
be done very easily using these icons. While working in Ms Excel, the user can add and remove any 
tool from the Quick Access Toolbar according to his needs. Clicking on the Drop down Arrow of this 
Toolbar, the Customize Quick Access Toolbar will be visible.

Fig. 4.1 Access Toolbar

If you click on the tool that will be added to the toolbar, a check mark [] will appear on the left side of 
the tool and the tool will appear in the Quick Access Toolbar. To exclude a tool from this Toolbar, click 
on the check mark [] next to that tool in Customize Quick Access Toolbar and the tool will not appear 
in Quick Access Toolbar. 
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Title Bar: This bar is located at the very top of the Excel window, and contains the name of the program 
along with the name of the file (workbook), e.g. “Microsoft Excel-Book1”. 

Ribbon: A notable addition to Excel 2007 is the Ribbon Tabs, located below the Quick Access Toolbar. 
By default, Home, Insert, Page Layout, Formulas, Data, Review and View are the seven ribbons. Each 
Ribbon contains several Command Groups, each of which contains an associated Command button. 
For example, the Command Groups located on the Home Ribbon tab are Clipboard, Font Alignment, 
Number, Styles, Cells, etc. 

Fig. 4.2 Ribbon tabs 

Worksheet: Worksheet is a Page of Workbook. An Excel file or workbook primarily consists of 
three worksheets. If necessary, the number of sheets can be increased or decreased. The bars that are 
visible horizontally in an Excel Worksheet are called Rows. Rows are numbered from top to bottom 
as 1,2,3,4... The total number of such Rows in a Worksheet is 1,048,576 The bars located vertically in 
the Worksheet are called Columns. Columns are named A, B, C, D,..... The total number of columns in 
the worksheet is 16,384. The intersection of a Row and a Column is known as a cell. Cells are named 
according to Column and Row names. For example, the name or address of the cell that will be created 
at the intersection of Row 10 and E Column will be E10. Clicking on a specific cell with the mouse 
pointer selects that cell. This cell is called Active Cell or Cell Pointer. Active Cell is covered by a thick 
line. At the bottom right corner of the Active Cell there is a small black box called the Fill Handle. 
The cell pointer within the worksheet can be moved up, down, right or left using the various arrow 
keys. Multiple worksheets can be added together in Excel and given different names instead of default 
names like Sheet 1, Sheet 2 etc. 

Formula Bar: The white horizontal section below the Ribbon tab is the Formula Bar. In this part, a 
formula is usually written or data is typed to enter data in a cell. If data is written in a cell, it is seen at 
Formula Bar. 

Name Box: Just to the left of the Formula Bar there is the Name Box. In this box, the address of a 
currently selected cell or a cell range is displayed. 

Scroll Bar: Vertical and Horizontal Scroll Bar is used to move the Worksheet up or down and right or 
left respectively. 
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Sheet Tab: Click on this Tab to go from one Worksheet to another Worksheet. The sheet tab that is 
clicked on that sheet is active. If you click the right button of the mouse when a Worksheet is selected, 
you can insert a new sheet, delete a sheet, rename a sheet, copy or move a sheet from the edge menu. 

Status Bar: This bar is located at the very bottom of the Excel window. The Status Bar displays r certain 
special keys, such as Caps Lock, Scroll Lock, etc. are whether on or off. If the Ready text is visible in 
this bar, it should be understood that the Cursor is located in the Worksheet Cell and in this state data 
can be written in the Worksheet. 

4.3.1 Data Entry in Worksheet 

Before discussing this topic it is necessary to know about what kind of data can be entered in Excel 
Worksheet. MS-Excel is able to identify the type of data being entered; Excel does not have to tell it 
the data type. In Excel Worksheet, generally four types of data entry can be done. These are discussed 
below. 

Labels or Text: This type of data is descriptive information, based on the English alphabet, such as the 
name of a person or month or any sentence etc. The text data is consists of letters from A-Z, numbers 
from 0-9 or special characters like @, #, $, & etc. For example, “My name is Sachin” is treated as a 
label or text in Excel. “There are 4 numbers” is also a textual data. No mathematical operation can be 
done on such data. 

Value or Number: This type of data is number. For example, 235 is treated as value in Excel, but 
“Number 235” is treated as label or text. In Excel comma or currency symbol may be used with large 
number. Mathematical operations can be easily done on this type of data. 

Date and Time: Excel treats date and time as separate data types. For example: date can be written in 
Excel in various formats like 14-Mar 01 Mar 01. 03-14-01 etc. 1:30:55 PM, 13:30 1:30PM 13:30:55, 
13:30:55 PM etc. are examples of Time data. 

Boolean Value: This type of data is not used in the above cases, but Boolean Value is used in logical 
formula. To write something in a Excel cell, first select that cell. Then type with the help. of Key Board 
and press Enter. Then the cell pointer will move to the cell below the specified cell and the typed data 
will be entered in the specified cell. Alternatively, if you put the cursor in a cell and type the data in the 
Formula Bar, then the data automatically enter into the cell. After the data entry in the cell, Excel aligns 
the data according to the type of the data. But the user can change that alignment later. Excel aligns text 
data to the left of the cell, aligns the value or number to the right of the cell, and also aligns the date to 
the right of the cell. When entering a label or text in a cell, as soon as you type the first few characters, 
Excel fills the cell with a similar label (a label starting with those characters if already entered in the 
another cell). This feature of Excel is known as Auto complete for data entry. This feature of Excel 
makes it easy to type homogeneous labels. If the width of the value entered in a cell is greater than the 
width of the cell, then Excel fills the cell with several # symbols. To show the value or number properly, 
the width of that cell should be increased as necessary. Some data are numbers but are used as text. Like 
telephone number, pin code etc. If a number needs to be entered as text, then type a single quotation 
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mark (‘) at the beginning and then type the number. Excel treats any number typed in this way as text 
and aligns it to the left. 

4.4 Data Editing 

If any changes have to be made after entering data in a cell of Excel worksheet, then double click 
on the cell, the cursor will move to the cell and the data of the cell can be edited. Various processes of 
data editing in Excel are described below- 

Data Formatting 

Cell formatting is the method of decorating the text, numbers etc. entered into different cells of 
Excel Worksheet with Font, Size, and Color etc. Formatting of data can be done by clicking on dialog 
box launcher at the bottom right of the command group Font, Alignment, Number, etc. of Home Ribbon 
with the help of buttons and then using different options of Format Collective box. Again, if “Format 
Cells” option is clicked from the menu obtained by right clicking on a cell the “Format Cells” dialog 
box will appear. The “Format Cells” dialog box has different types of tabs, such as Number, Alignment, 
Font, Border, Fill and Protection. Data can be formatted by selecting various formatting options from 
these tabs. 

Number tab: With the help of this tab, the type of data to be inserted in a cell is decided. Select the 
required data type (General, Number, Currency, Date Time etc.) from the Category List and then click 
OK. 

Alignment Tab: After inserting data into a cell, the Alignment tab determines how it is arranged. 
horizontally or vertically in that cell. In this case, according to the need, the data can be kept in a cell at 
different angles. If the data entered in a cell is larger than the width of that cell, then part of the text goes 
to the next cell. But if you select the Wrap Text option of the Alignment tab, the text of that cell moves 
to the bottom of that cell instead of going to the next cell. As a result, the height of the cell increases 
slightly. 

Font tab: Font name, Font style (Regular, Italic, Bold etc.), Font size, type of underline, text color, 
Effects etc. can be changed through various options under this tab. 

Border tab: With the help of this tab, a border can be drawn as required, around any cell or selected 
cell group. Border style (single line, double line, dotted line etc.) and color of the border can also be 
determined with the help of this tab. 

Fill tab: This tab is used to give a color or a special pattern to the inner side or background of a cell. 

Protect Tab: One or more cells can be protected through the Protection tab. As a result, no data of those 
cells can be changed or deleted. To protect a cell, click on the Locked check box of the Protection tab. It 
is particularly noteworthy that before protecting any cell, the Worksheet must be protected through the 
Protect sheet button of the Review tab. 

Copy and Paste of Information 

Follow the steps below to copy and paste data in MS Excel. 
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•	 First select the cell or cells that need to be copied. 
•	 Click the Copy button from the Clipboard command group on the Home tab or press Ctrl+C from 

the keyboard. A copy of the data of that cell or cell range will go to the Excel clipboard. 
•	 Place the mouse pointer in the cell where the data is to be copied. 
•	 Click the Paste button from the Clipboard Command Group or press Ctrl+V from the keyboard. 

Then the clip board data will be pasted in the selected cell. 

Drag and Drop 

Data can also be copied through Drag and Drop process in Excel. Follow the below procedure to 
complete this task 
•	 First select the cell or cells that need to be copied. 
•	 When you move the mouse pointer over the border of the selected cell or cells, the pointer changes 

to an arrow. 
•	 Now holding the Ctrl key and dragging the border of the selected cell or cells, this information will 

be copied to another blank cell. 

Cut and Copy of Information 

The method of cutting and pasting data in MS-Excel is described below. 
•	 If you cut the data of a cell, the data is deleted from that cell. 
•	 Select the cell or cells that need to be cut and click the cut button of the clipboard command group 

of the Home tab of the Ribbon or press Ctrl+X on the keyboard. 
•	 Keeping the mouse pointer in the cell where the data to be pasted, click the Paste button from the 

clipboard command group or press Ctrl+V keys on the keyboard, the data will be pasted in that cell. 

4.5 Working with Workbook 

The various operations that can be performed on a workbook in MS Excel are discussed in detail 
below. 

(A) Creating New Workbook 

When Ms Excel 2007 is opened, a blank workbook is displayed on the screen with named Book1 written 
in the title bar. One or more new workbooks can also be created while Excel is running, by following 
the steps below. 
•	 Clicking on Office button and then clicking on New Command will show New Workbook dialog 

box on the screen. 
•	 Click on Blank and recent button. 
•	 Then clicking on Create button will create a new workbook. 

(B) Saving the Workbook 

After entering the necessary data in the worksheet, the following steps must be followed to save the data: 
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•	 Click on the Microsoft Office button and click on the Save or Save As option. The Save As dialog 
box will appear on the screen. 

•	 Enter a logical name of the File in the File Name Box. 
•	 Click on Save button. 

Press Ctrl+S to save using keyboard. File name extension in Excel 2007 is .xlsx 

(C) Opening a Workbook 

To open an existing workbook, follow the steps below. 

Click on Office button and then click on Open option or press two keys (Ctrl+O) from the keyboard. 
•	 Select the location of the saved workbook by clicking on the arrow symbol of the look in text box 

from the open dialog box that appears on the screen. 
•	 Select the specific workbook or file and click on the open button to open the file. 

(D) Deleting Cell Information 

To delete the data of a particular cell, follow the procedure below. 
•	 To delete the data of one or more cells, select the cell or cells. 
•	 Press the delete key on the keyboard. In this case the data of the selected cells will be deleted. 

(E) Inserting New Row 

In many cases while working with Worksheets it is necessary to insert a new row. In that case follow the 
procedure below to insert a new row into the worksheet. 
•	 Select the row by clicking on the heading of the row above which the new row is to be inserted (if 

only one row is to be inserted). To insert multiple Rows, select the Rows above which we want to 
insert multiple rows. 

•	 Click on the Insert Sheet Rows menu appears after clicking the Insert button in the Cells. Command 
group of the Ribbon’s Home tab a new Row will be added every time you click on it. 

(F) Inserting New Column 

To insert a new column in a Worksheet, the following procedure is to be followed. 
•	 To insert a single column, select the column on clicking on the heading of that column, left of which 

the new column is to be inserted. If you want to insert multiple columns, select the columns, left of 
which the new columns are to be inserted 

•	 A new column will be created every time you select Insert Sheet Column by clicking the Insert 
button in the cells command group of the Home tab. 

(G) Deleting Cell, Row or Column 

To delete Cell, Row or Column from any Worksheet, the procedure is described below. 
•	 First select Cell, Row or Column which needs to be deleted. 
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•	 To delete the selected cell, Home tab -> Cells -> Delete -> Delete Cells these steps to be followed. 
•	 To delete selected Rows, Home tab -> Cells -> Delete -> Delete Sheet Rows - these steps to be 

followed. 
•	 To delete the selected columns, follow these steps: Home tab -> Cells -> Delete -> Delete Sheet 

Column. 

(H) Resizing Row and Column 

If you bring the mouse pointer to the border of two Row or two Column headers, when it takes 
resizing shape, the Row or Column can be easily resized by clicking and dragging the mouse. Besides, 
when the mouse pointer is brought at the boarder of two Row or two Column labels, the mouse pointer 
takes the resizing shape, and then if you double click the mouse, the Row or Column will automatically 
be resized according to the data of the Cell. 

Alternative methods of Row Resize are discussed below. 
•	 Select the entire row by clicking on the header of the row whose height is to be increased. 
•	 Click the Format button in the Cells Command Group of the Home tab and click Row Height, the 

row height dialog box will be visible. 
•	 Enter the required number in this box and click on the ok button to change the row height. 

Column Resize options are shown below. 
•	 Click on the column header to select the entire column. 
•	 Clicking the Format button in the Cells Command Group of the Home tab and clicking column 

width will display the column width dialog box. 
•	 Enter the required column width in this box and click on the ok button to change the column width. 

(J) Auto Fill 

With the help of auto fill method, the same type of data, sequential data, formula etc. can be inserted 
continuously in a specific column or row of the worksheet. The example below shows how to auto fill 
using the Fill Handle. 
Example: Name of the seven days of the week (Sunday - Saturday) Auto fill method: 
	 i)	 Sunday should be typed in any cell of the Worksheet. 
	 ii)	 By selecting the cell written Sunday, bringing the mouse pointer on Fill Handle, the Mouse Pointer 

will turn into ‘+’ sign. 
	 iii)	 Press the left button of the mouse and drag downwards and stop dragging after “Saturday” text 

appears. As a result, the names of the seven days of the week from Sunday to Saturday will be 
inserted into the cells. 

Example: Method to fill cells with numbers from 1 to 10 or more consecutively. 
	 (i)	 First type 1 in a cell and 2 in the cell immediately below it. 
	 (ii)	 Then select cells 1 and 2 together. 
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	 (iii)	 Holding down the Fill Handle of the cell 2 with the left mouse button, drag it to the cells. below. 
	 (iv)	 The consecutive numbers 3,4,5,6 ......... will be visible and the mouse button should be released 

after the text 10 is displayed. 

4.6 Data Handling 

Data handling issues such as data fill, data sorting, data filter etc. can be done very easily in MS 
Excel. These operations can be done using the Data menu in MS-Excel. How to do data sorting is 
explained below. 

Data Sorting 

The method of arranging the data (text and number) in order of value, written in Column or Row 
in a Worksheet is called Data Sorting. Arranging the numbers in the same column or row from smallest 
to largest and the text according to A -> Z is called ascending order. Similarly, arranging numbers from 
largest to smallest and text according to Z -> A is called descending order. 

Sorting on a Column or Row 
	 (i)	 Select the cells that belong to the Column or Row that need to sort the data. 
	 (ii)	 By clicking on the Sort & Filter button in the Editing Command Group of the Home tab of the 

Ribbon and clicking on Sort A to Z from the menu, the cell data will be arranged in Ascending 
Order. Similarly clicking on Z. to A option will arrange the data in Descending Order. 

Sorting on multiple columns 
	 (i)	 Select the Column or Row data to be sorted. 
	 (ii)	 Click on the Sort & Filter button in the Editing Command Group of the Home tab of the Ribbon 

and click on Custom Sort from the menu obtained. The Sort dialog box will appear on the screen. 
	 (iii)	 Select the first column for sorting from the drop down list of the Sort by text box of the Sort 

dialog box. Select A to Z or Z. to A from the drop down list below Order to sort in Ascending or 
Descending Order. 

	 (iv)	 Then click on Add Level button of Sort dialog box. Here you have to select the second column 
from the drop down list of the Then by box and the third column by clicking the Add level button 
again if necessary. In each case A to Z or Z to A should be selected for sorting order. 

	 (v)	 Finally clicking on ok button will complete the sorting. 

4.7. Uses of Chart and Graph in Excel Sheet 

The method of displaying different data in Excel Worksheet is called chart or graph. Data entry in 
Excel Sheet 

Charts or graphs can be easily created on the sheet using Pie, Bar, Column Line, Area etc. are 
different in Excel Sheet 

Types of charts can be created. Chart Option provides different types of charts with images. Here it 
is up to the user to decide 
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Choose any type of chart that will be reasonable with your data. The special advantage of charts created 
in Excel is the worksheet data 

There is no need to create a new chart if there is any change. Data changes are automatically reflected 
in the chart. The various parts of the chart are discussed in detail below. 

Data Series (Data Series) - The numbers that are spread over the rows or columns of the Excel worksheet 
are plotted on the chart. Those numbers together are called data series. 

X axis (X-axis) - The horizontal line along which different categories (names of different columns) are 
expressed in a chart is called X-axis. 

Y-axis (Y-axis) - The vertical line along which a data value is expressed in a chart is called the Y- axis. 
Legend (Legend) - A legend is a number of symbols used to identify the purpose of a data series chart 
and to interpret each type of data separately. 

Gridlines - Charts have some horizontal and some vertical lines known as grid lines. The role of gridlines 
is very important in determining the value of any data from X-axis or Y-axis. 

Chart Area - The box around the chart in which the chart is located is called the chart area. 

Chart Title - Every chart has a title that identifies the chart. 

Plot Area - The part inside the chart area where the main chart is located is called the plot area. From 
Plot Area, The value of the data is known. 

4.7.1 Preparing Chart 

There are several ways to create charts or graphs in Excel 2007. The methods of making Column 
Chart, Line Chart and Pie Chart are discussed here. 

Preparing Column Chart
•	 Select the data range from the Worksheet to create the Column Chart based on the data range. 
•	 Click on the column button in the Charts Command group of the Insert tab of the Ribbon. A list with 

images of various column charts can be seen, such as 2D, 3D column cylinder, cone, pyramid etc. 
From there, click on the desired layout. 

•	 The Column Chart based on the selected data range can be seen in the Worksheet. The method of 
inserting the column church is shown in the diagram below.



64

Fig. 4.3 Column chart

Preparing Line Chart 
•	 To create a Line Chart, the required data lines must be selected from the Worksheet. 
•	 After clicking on the Line button in the Charts Command group of the Insert tab, a list of different 

types of Line Charts will be displayed. For example, 2D Line includes Line, Stacked Line, 100% 
Stacked Line, Line with Markers and 3D Line etc. One has to click on the specific layout from 
among them. 

•	 The Line Chart based on the selected data will be displayed in the Worksheet. 

Preparing Pie Chart 
•	 Select the data range from the Worksheet on the basis of which the Pie Chart has to be created.
•	 After clicking on the Pie button of the Charts Command Group of the Insert tab of the Ribbon, the 

layout of various Pie Charts will be displayed like Pie of 2D Pie, Exploded Pie, Pie of Pie and 3D 
Pie of Pie in 3D, Exploded Pie in 3D, etc. Click on the desired Pie layout.

•	 The Pie Chart created from the selected data can be seen in the Worksheet.
	 Below figure shows how to make Pie chart. 

Fig. 4.4 Pie chart 
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After creating a chart or graph in the Worksheet, the various changes regarding to Chart Design, Layout 
and Format can be done with the help of three additional Tabs e.g. Design, Layout and Format of the 
Ribbon. These Ribbon tabs are discussed below. 

Design Tab 

This tab contains five command groups named Type, Data, Chart, Layouts, Chart Style, and 
Location. With the help of the buttons present in this command groups one can Change the type of a 
chart, data selection, change the layout of the chart, change the style of the chart and change the location 
of the chart (moving the chart from one sheet to another sheet). 

Fig. 4.5 Design tab 

Layout tab 

Command groups on this Ribbon tab are current selection, Insert, Labels, Axes, Background, 
Analysis and Properties. With the help of these buttons in the Command group, you can select various 
parts of the chart, such as Chart Area, Chart Title Legend, Plot Area, etc. can be done 

Format Tab 

This ribbon tab has five command groups Current Selection, Shape Styles, Word Art, Arrange, 
and Size. With the help of these buttons different parts of Chart like Chart Area, Chart Title. Plot Area, 
Legend etc. can be given various colors, line color, shadow effects, chart shape style. changed etc. 

4.8 Printing Worksheet 

Before printing a worksheet, the page should be properly arranged (e.g. Page-Size, Margin, 
Orientation, Header, Footer etc.). Clicking on page setup from Page Layout tab will open the Page Setup 
dialog box. The various tabs of this Page setup dialog box are discussed below. 
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Fig. 4.6 Page Setup 
Page Tab 
•	 Select how the page will be printed from the Orientation area, such as Portrait or Landscape. 
•	 Select the required paper size (e.g. A4, A3, Legal etc.) from the Paper size drop down list. 
•	 Select the correct resolution (dots per inch) from the Print Quality drop down list. 
•	 If you want to start from a number other than Page 1 then type the page number in the First Page 

number box. 

Fig. 4.7 Page tab 
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Margins Tab 

Clicking on the Margins tab of the Page setup dialog box will open this tab. 

Fig. 4.8 Margins tab 

From the Top, Bottom, Left, Right box, specify how much margin should be set at the top, bottom, left 
and right of the page respectively. 

Header/Footer Tab 

To set the Header and Footer of a page, click on the Header Footer Tab. 

Fig. 4.9 Header/Footer tab 

To create a new Header or Footer as per your choice, click on the Custom Header or Custom Footer 
button respectively. In that case, a new dialog box will appear where the necessary text entry has to 
be done. Here the text can be formatted and page number, total number of page, date, time etc. can be 
inserted in Header or Footer. 
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Sheet Tab 

The options on this tab are discussed below. 

Print Area : By clicking this box, how much part of a worksheet will be printed is specified. 

Fig. 4.10 Sheet tab 

Rows to repeat at top: By clicking on this box, which rows will be printed on each page is selected. 

Columns to repeat at left: By clicking on this box, which columns will be printed on the left side of 
each page is selected. 

Gridlines: Selecting this box will print gridlines on every page. 

Print Preview 

When the Page Setup is finished, how the worksheet will look after printing can be seen through the 
print preview. To view the print preview, click the Print Preview button in the Page Setup dialog box or 
select Print Preview by clicking the Microsoft Office Button or press Ctrl+F2 from the keyboard. 

Print 

To print a worksheet, click on the Microsoft Office Button and select Print or press Ctrl+P from the 
keyboard. Then the Print dialog box will open. The options in the Print dialog box are discussed below 
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Fig. 4.11 Christ dialog box 

Name: Select the name of the printer to be printed from this box. 

Print Range: It is decided which pages will be printed from this option. 

Print What From this box it is decided what to print. To print the selected part select the option 
Selection, to print active Sheets select the option Active Sheets and to print entire workbook select the 
option Entire Workbook. 

4.9 Use of Formula in Ms Excel 

One of the most essential uses of Ms-Excel is to perform calculations using various mathematical 
formulas. A formula establishes a relationship between two or more cells in a worksheet. The method of 
calculation using the formula is discussed below. 

Inserting Formula in Cell 

To insert a formula in a cell, follow the steps below. 
	 (i)	 Select the cell by clicking on the cell in which the formula is to be inserted. 
	 (ii)	 Type the symbol ‘=’. 
	 (iii)	 Then the formula should be entered after the symbol ‘=’. 
	 (iv)	 Finally press Enter key. 

Instead of typing a formula directly into a cell, a formula can be typed in the formula bar. Once the 
formula is typed, pressing the enter key will display the result of the formula in the selected cell. The 
method of insertion and copying of formula is shown using the diagram below. 
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Fig. 4.12 Inserting the formula 

An example of how to perform a specific function using formulas in MS-Excel is discussed below 

Example: To determine the Average of the numbers in cells Al to AS. 

Fig. 4.13 Determining the mean of numbers 

To complete the above task follow the below procedure. 
	 (i)	 Cell A6 can be selected to display the result. 
	 (ii)	 “= Average (A1:A5)” should be typed. 
	 (iii)	 Enter key should be pressed. 

Cell A6 will display the average of the numbers. 

4.10 Functions of MS Excel 

To know about all the functions that are available in MS-Excel, first select the Formula tab. Then 
click on the Insert Function button, then the dialog box of Insert Function will be displayed. 
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Fig. 4.14 Excel functions 

Excel functions can be found and used according to category in this box. Excel has many types of 
Mathematical and Statistical functions. Some of these important functions are described below. 

Abs (Number) - This function returns the Absolute Positive Value of the number used as a parameter.
	 Example:	 Abs(20) returns 20
			   Abs(-20) returns 20 

Int (Number) - This function returns the nearest integer & rounds up the number used as parameter. 
	 Example:	 Int (5.3) returns 5 
			   Int (6.8) returns 7 

Mod (Number, divisor) - This function returns the remainder after dividing the number by the divisor. 
	 Example:	 Mod(89, 10) returns 9 
Sqrt (Number) - This function calculates the square root of the number used as argument. 
	 Example: 	 Sqrt (25) returns S 

Sum (Number 1, Number 2....) - This function returns the sum of the numbers. 
	 Example: 	 Sum (20, 30, 50) returns 100 

Average (Number 1, Number 2) - This function calculates the average of the numbers. 
	 Example: 	 Average(10, 20, 30) returns 20 
Max (Number 1, Number 2....) - This function returns the largest number among the numbers. 

	 Example: 	 Max(50, 120,70) returns 120 

Min (Number 1, Number 2....) - This function returns the smallest number among the numbers. 

	 Example:	 Min (50, 120,70) returns 50 

Use of Autosum: 
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Autosum button is very useful to calculate the sum of several numbers very easily and quickly. 
	 (i)	 First click on the cell in which sum is to be calculated. 
	 (ii)	 Click on Auto Sum button from Home Tab. 
	 (iii)	 Select the cells whose sum is to be calculated. 
	 (iv)	 If you click on Auto Sum button again, the sum will be displayed immediately. 

4.11 Summary 
•	 This chapter discusses a widely used spreadsheet package called MS-Excel. 
•	 MS-Excel is an important tool of MS Office with the help of which any mathematical calculation 

work, preparation of chart etc. can be done very easily and quickly. 
•	 An Excel File is called a Workbook which consists of multiple Worksheets. An Excel File extension 

is .xlsx. The portion of the worksheet that appears on the screen is much larger than the actual 
worksheet. A worksheet consists of many Rows and Columns. The junction of a row and a column 
is called a cell. Data entry is done in this cell. Cells are named according to column and row names. 
If you type any information in a cell and press Enter, that information is stored in the cell. 

•	 The width of Row & Column in Excel Worksheet can be changed with the mouse. Here although 
the Copy and Paste method is similar to MS Word but there are slight differences. 

•	 Charts, graphs etc. can be created beautifully in Excel Worksheet. This chart or graph can be edited 
and copied and pasted into another file. 

•	 Another important use of Excel is to solve long and complex problems using various mathematical 
and astrological formulas. Besides, Excel can be used to prepare various mathematical formulas.  

4.12 Unit End Exercise 
	 (1)	 What is meant by MS-Excel? Where MS Excel can be used?
	 (2)	 Discuss the method of adding information in a worksheet.
	 (3)	 Discuss with example how to draw a Pie Chart in MS-Excel.
	 (4)	 What is Auto complete in Excel? 
	 (5)	 Discuss the functions of Formula Bar. 
	 (6)	 How the content of a Cell in Excel can be deleted? 
	 (7)	 Discuss in detail any four of the functions that can be used in Excel.
	 (8)	 What does Spreadsheet mean? 
	 (9)	 Write the total numbers of Row and Column in an Excel worksheet. 
	(10)	 What is the function of Name Box? 
	(11)	 What does C37 mean? 
	(12)	 How to copy by Drag and Drop method
	(13)	 How to add new Column in a Worksheet? 
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	(14)	 How to insert a new Row in a Worksheet?
	(15)	 What do you mean by Chart? 
	(16)	 Discuss the different parts of an Excel Chart. 
	(17)	 Describe the procedure to draw a Column Chart. 
	(18)	 How to print an Excel worksheet? 
	(19)	 What is Autosum? 
	(20)	 Explain how to find the mean of numbers using the formula. 

Project Work 
(1)	 Do the work as directed. 

(a)	 Write three separate words In cells A1, A2 and A3. 
(b)	 Write three numbers in cells B1, B2 and B3. 
(c)	 Calculate the sum of the above numbers using Autosium by clicking on the B4 cell.
(d)	 Change the width & height of Column and Row respectively. 

(2)	 Create the tabulation sheet below with the help of suitable Excel function. 
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N.B. :	 Total		  = Language 1+Language 2+ Math+Science+History +Geography +EVS
	 % of Marks	 = Total/7
	 Grade		  = A (% of Marks >=90) 
			   = B (% of Marks >= 70 but<90) 
			   = C(% of Marks 50 but <70) 
			   = D (% of Marks 40 but <50) 
			   = E (% of Marks <40) 

(3)	 Construct a bar chart using the data in the above table.
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UNIT
5

Using Power Point in 
Teaching Learning Process

5.1 Introduction

5.2 Objectives of the Unit

5.3 Basic Concepts of Power Point

5.4 Concept of Views in Power Point

5.5 Slide Design

5.6 Slide Show and Slide Printing

5.7 Planning Lessons by Using Power Point

5.8 Summary

5.9 Unit End Exercises

5.1 Introduction 

Power Point is one of the most essential application software of Microsoft Office. PowerPoint is 
very useful for presenting a topic beautifully. For this reason it is also called presentation software. 
In this software, the content can be presented attractively to the audience using the necessary images, 
graphs, charts, sounds, motion, colors etc. An important aspect of PowerPoint is that content can be 
presented at any level. From pre-primary level to university level and even at research level, the use of 
PowerPoint has played an equally effective role. Advantages of using PowerPoint are- 
•	 Presentations made by Power Point can be displayed on different mediums; for example, computer 

screen, projector, LCD or LED, TV, Digital Screen etc. 
•	 It is possible to print slides used in presentations made using PowerPoint. 
•	 Power Point presentations can be easily modified or updated. 
•	 It is possible to add audio and video clips directly to PowerPoint presentation slides. 

5.2 Objectives of the Unit

After reading of this unit learners will be able to-
•	 Make a presentation using Power Point. 
•	 Use various wizards in PowerPoint. 
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•	 Add images, graphs, designs, etc. to PowerPoint. 
•	 Add sound, animation to slides. 
•	 Print slides. 
•	 Prepare lesson plans through PowerPoint. 

5.3 Basic Concepts of Power Point 

MS-Power Point is one of the most essential parts of MS Office package. A PowerPoint file is 
called as presentation. Just as a file can have many pages, a PowerPoint presentation can have many 
slides. Also-handouts, speaker notes, outlines, etc. can be in the presentation. Video Slide show, Web 
presentation is also possible through power point. Power point presentation is discussed in detail below. 

5.3.1 Presentation through Power Point 

To represent a PowerPoint presentation, it is usually made up of one or more slides. To open Power 
Point, first click from Desktop to Start → All programs → Microsoft office → Microsoft Power Point, 
then Power Point will open. Below is an image of the Power Point window. Presentations can be made 
with PowerPoint in two different ways. The first is with the help of Design template and second is using 
Blank Presentation. These are discussed below. 

Creating a new presentation with the help of a design template: 

To make a presentation in this way, you must first click on the Power Point office button. Then 
click on New Option, the New Presentation dialog box will open. After clicking on Installed Template 
Option, you will see the image below. There, if the user selects the Template according to his/her need 
and clicks on the Create Button, that template will be opened. In this case, the project will have many 
slides and the user can edit them as he likes. 

Fig. 5.1 PowerPoint window 
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Creating new representations with Blank Presentations: 

In this way, if you click on the office button of Power Point and then click New option, a New 
Presentation will open. On clicking Blank and Recent Option there, Blank Presentation option will 
be available. After selecting the Blank Presentation Option and clicking on the Create Button, a 
Blank Presentation will be created and this window screen is completely blank. User can create new 
presentation using the design of his/her choice. 

The various ribbon tabs in Microsoft PowerPoint 2007 are Home Ribbon tab, Insert Ribbon. tab, 
Design Ribbon tab, Animation Ribbon tab, Transition Ribbon tab, and Slide Show Ribbon tab. These 
are highlighted below. 

Home Ribbon Tab: This ribbon tab is formed by the commands such as Cut, Copy, Paste, Font Size, 
Bold, Italic, Underline etc.. The Clipboard, Slide, Font, Paragraph, Drawing, and Editing command 
groups etc. also belong to this Home Ribbon tab. 

Fig. 5.2 Home ribbon tab

Slide Command Group - This command group includes New Slide drop down menu, Slide Layout 
drop down menu, Reset option, Delete option, Section drop down menu etc. Below is an illustration of 
the slide commands. 

Fig. 5.3 Slide command group 



77

Insert Ribbon Tab - This ribbon is consists of Table, Image, Illustration, Line, Text, Symbol and 
Media-clips command group. Using this ribbon tab one can introduce the various objects such as Table, 
Picture, Clipart, Photoalbum, Shape, Chart, Text Box, Header and Footer, Word Art, Date & Time, Slide 
Number, Symbol, Object, Movie Sound etc. In a presentation. 

Fig. 5.4 Insert tab

Design Ribbon Tab - This ribbon tab contains three command group like- Page Setup, Theme and 
Background. The Design Ribbon tab is shown in the figure below. 

Fig. 5.5 Design ribbon tab

Animation Ribbon Tab - Using various command groups from this tab one can apply different types 
of animations from Preset or Custom animation tab to the different objects such as Wordart, Picture, 
Drawing, Clipart, Text etc. among the previously created slides as per need. The Animation Ribbon tab 
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has three command groups, namely the Preview command group, the Animation command group and 
the Timing command group. These are described below. 

Fig. 5.6 Animation ribbon tab

(a)	 Preview command group - Animation added to slides by this command group can be seen before 
slide starts. 

(b)	 Animation Command Group - This command group contains two tools - Preset Animation Tool 
and Custom Animation Tool. Clicking on the Custom Animation Tool Box will bring up a Task 
Panel. Various animations are available from the Add Effect button located in this Task Panel, from 
where the users can add animation to the various functions of a slide according to their own choice. 

(c)	 Timing command group - The various characteristics of the animations added to the slides by this 
command group such as timing, duration, starting time, which will run earlier, which will run later 
etc. can be set according to the user’s choice. 

Transition Ribbon Tab - This ribbon tab contains three command groups: Preview, Slide Transition, 
and Timing. These are discussed below. 

Fig. 5.7 ‘Transition Ribbon Tab 
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(a)	 Preview command group - By this command group the animations and transitions added to the 
slides can be shown before the starting of slide show. 

(b)	 Slide Transition Command Group - This command group includes Split, Cut, Wipe and Effect 
options. 

(c)	 Timing command group - The most important command group in the transition ribbon tab is the 
timing command group. This includes sound. With the help of this command group, the functions 
such as duration between two slides, automatic display of slides in succession, method of showing 
slides by mouse click etc. can be done. 

Slide Show Ribbon Tab - This tab mainly has three command groups; namely - Start Slide Show, Set 
Up and Monitor. These are highlighted below. 

Fig. 5.8 Slide show ribbon tab

(a)	 Start Slide Show command group - There are four options in this command group. Such as From 
beginning, From current slide, Broadcast slide show and Custom slide show By clicking on the 
From beginning option, the slides will be displayed from the very beginning and by clicking on 
the From Current Slide option, the slides will be displayed from the slide that the mouse pointer is 
currently on. Clicking on Custom Slide Show will display a dialog box, from where the user can 
arrange the slides and display them sequentially. 

(b)	 Set-up command group - The options in this command group are Set-up Slide Show, Hide slide, 
Record slide show and Rehearse Timing. To set up various options related to the slide show, click on 
Set-up slide show, then a dialog box will appear and select any of the Set-up radio buttons located 
in this dialog box and click the OK button. The Hide Slide option in this command group can be 
used to hide a particular slide as needed. In addition, with the help of the next two options of this 
command group, record slide show and rehearse timing, the entire slide show can be presented 
automatically by recording the presentation time of each slide of a slide show. 
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5.4 Concept of Views in Power Point 

Various views in Power Point are discussed below. 

Normal View - Usually when any work is done in Power 
Point, this is done in the normal view. Slide design is done on 
this basis. 

Slide Sorter View - With the help of this view, all the slides 
of a presentation can be seen together. All slides in this view 
are displayed as thumbnails. A slide can be deleted if deemed 
unnecessary. 

Slide Show View - Presentation is presented with the help of 
this view. In this view the slide occupies the entire screen of 
the computer monitor. Press Right Arrow (→) on the keyboard 
to view the next slide in this view. 

Outline View - With this view, only the texts on the slides are visible. 

5.5 Slide Design 

Various topics related to slide design in MS-Power Point are described below. 

Inserting New Slide 

To add a new slide in Power Point, click on the slide tab, 
then all the slides of the presentation will be seen consecutively. 
After that select the slide with which you want to add the new 
slide. In addition, clicking on the down arrow of the New slide 
option in the slide command group will open the slide layout 
gallery. From there, if the user selects the slide of his choice, 
the slide will be inserted. Another way to insert a slide is to 
right click on the slide after which the new slide is required in 
a presentation, and click New slide. The keyboard shortcut to 
create a slide is Ctrl + M. 

Inserting Clip Art, Picture, Graph 

To add clip art to a slide, follow this procedure: insert → 
clip art. Then select the desired image and double click on it 
or select and press OK button. Then the desired image will be 
added to the slide. 

To insert a picture to a slide, first Insert → Picture method 
is to be followed. Then select the desired image and click OK 
to add the desired image to the slide. 

Fig. 5.9 Views in Power Point

Fig. 5.10 Adding a new slide

Fig. 5.11 Side design
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To add a graph or chart to a slide, select the slide first. Then click on the Chart command in the 
Illustration command group of the Insert tab to display the Insert Chart dialog box. After selecting the 
required chart and pressing OK, a dummy chart will appear and an MS-Excel file will open next to it. 
The chart will change according to data addition or deletion i.e. data editing. After editing is over, the 
Excel file is to close and save. 

Use of Text Art or Word Art in Power Point 

To add Word Art to Power Point, click on the Word Art 
option in the Text command group of the Insert tab. Select 
the preferred style from the gallery and the text “Your Text 
Here” will appear on the slide. Now the text should be 
edited as necessary. 

Use of Animation, Movie Clip and Sound 

The dialog box will open if you first select the object of 
the slide to which the animation needs. to be added and 
click on Custom Animation from the Animation group of the 
Animation tab. Then click on Add Effect Button and four 
options (Entrance, Emphasis, Exit, Motion Path) will be 
displayed. Select effect as required and click on Play or Slide 
Show button to preview the animation. To add a movie to a 
slide, click the down arrow for Movie in the Media Clips group 
on the Insert tab. In this case there are two options like - Movie 
from file and Movie from Clip organizer will be shown. On 
clicking Movie from file option - you have to select the movie 
file from the computer. On the other hand, if you click on Movie 
from organizer, the Clip Art dialog box will open with some 
movie clips. Then select the desired movie. 

The procedure for adding sound is similar to that of a 
Movie clip. Here, clicking on the sound down arrow of Media 
Clips in the Insert tab will bring up two options: sound from 
file and sound from clip organizer. Click on Sound from file 
to select sound from computer. On the other hand If you click 
on sound from clip organizer, many sound options including 
clip art sound will appear and you have to select the sound you 
like. After that a message will appear with two options, one is 
Automatically and the other is when clicked In this case, if you 
select. Automatically, the sound will play when the sound comes 
on the screen. On the other hand, when clicked is selected, the 
sound icon will not sound until it is clicked. 

Fig. 5.12 Adding charts and images

Fig. 5.13 Adding word art

Fig. 5.14 Use of animation
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Fig. 5.15 Using movie clips Fig. 5:16 Use of sound

5.6 Slide Show and Slide Printing 

First the presentation to be displayed should be opened. Then click View → Slide Show in this 
order. The same can be done directly with the help of F5 button. Then press the Page Down Key on the 
keyboard to move to the next slide. To exit midway during the 
slide show, press the Esc button on the keyboard. 

Select Print option from Office Button to print slides in 
Power Point or press Ctrl + P to open the Print dialog box. 
Select the various printing options here and click OK to 
start printing. If you want to see the print preview before 
printing, click Print → Print Preview from the Office button 
accordingly. 

Incidentally, if you select the current slide and give the 
print command, only the specified slide will be printed. Again 
select the Slide option and as many numbers are written in the 
text box as many slides of the presentation will be printed. 

5.7 Planning Lessons by Using Power Point 

To prepare a lesson plan through Power Point the student needs to keep the following points in mind 
before making the slides. 

•	 Before preparing the slide, it is better to collect the content 
that will be written on the slide in one place and write it 
down in a notebook. 

•	 Preselect which images, diagrams, or clip art will be placed. 

•	 Slide titles can be bolded and capitalized and it is best not 
to exceed the font size 20. 

•	 A slide should not have too many lines. 

•	 If you want to place the table, it should not be too big.

Fig. 5.17 Slide presentation

Fig 5.18 Hide printing
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An example of Lesson Plan using Power Point is shown below: 

District Institute of Education and Training 
Kalanabogram, Bardhaman 

Trainee Teacher Name: Sourav Mondal 

Roll No.-17 

Session: 2013-15

Class: IV 

Unit: PICNIC 

Sub Unit: PICNIC 

Today’s Lesson : PICNIC 

Time: 40 Min.

PICNIC 

Golam Mustafa 

Nuru, Pushi, Ayesha, Shafi — all have come, 
As if they laughed under the Mango Yard! 
Cooks’ hobby coocking has fallen, no one, 
Sleeps in this afternoon of Boshekh month. 

Parents are sleeping with them, having this benefit 
A few naughty girls met today at the picnic!
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Write the meaning: 
Yard 

A: Garden 

Sweet 

A: Honey 

Q: Who have came to play the Picnic? 
A: Nuru, Pushi, Ayesha and Shafi 
Q: Where did all come to play? 

A: Under the mango garden 

No one has sleep in this afternoon of the month 
All have sit to _____________ preparation

Write sentences with the words: 
PICNIC 

PREPERATION 
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District Institute of Education and Training 
Kalanabogram, Bardhaman 

Trainee Teacher Name: Sourav Mondal 
Roll No. - 17 

Session: 2013-15

Subject: Mathematics learning using Computer 

Class : VIII 
Unit : Rectangular Parallelepiped 

Sub Unit: -Do- 
Today’s Lesson: -Do- 

Time: 40 Min. 

Height (c)

Length (a)

Breadth (b)

Total Surface Area of Rectangular Parallelepiped 
= 2 (Length x Height + Length X Breadth + 

Height X Breadth) 
= 2 (a X c + a X b + b X c)
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Height (c)

Length (a)
Brea

dth (b)

Choose the right alternative: 

1.	 Total No. of surfaces of a rectangular parallelepiped is 
		  a) 4 		  b) 3 		  c) 6 

2.	 No. of vertices of a rectangular parallelepiped is 
		  a) 6 		  b) 8		  c) 4 

3.	 Total surface area of a rectangular parallelepiped with length 
6cm. breadth 3cm. and height 2cm. is 

		  a) 36 sq.cm 	 b) 72 sq.cm	 c) 54 sq.cm 
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1.	 Total surface area of a cuboid with side 5cm. is
	 a) 125 sq.cm 	 b) 150 sq.cm	 c) 25 sq.cm 

2.	 The volume of a cuboid with side 5cm. is 
	 a) 125 c.c 		 b) 150 c.c 	 c) 600 c.c 

5.8 Summary 
•	 In this chapter PowerPoint of Microsoft Office is discussed. PowerPoint is an important tool within 

Microsoft Office applications. It is also called a presentation software. 
•	 PowerPoint has four views - Normal View, Outline View, Slide View and Slight Shorter View. 
•	 Text, images, clip art, charts, graphs, etc. can be added to the slides as needed. To make the slide 

interesting Animation templates, sounds etc. can be added. 
•	 Pre-fixing the topics of the slide presentation makes the presentation easier. 

5.9 Unit End Exercises 
(1)	 What is power point? 
(2)	 What are the things that are need to be known to make a presentation on Power Point? 
(3)	 How to add images to slides? Discuss in detail. 
(4)	 How to add charts from Excel to slides? Discuss in detail. 
(5)	 What are the advantages of using PowerPoint? 
(6)	 How to add a sound or video clip to a slide? 

Project Work 
(1)	 Prepare a lesson plan in Power Point as per your choice at upper-elementary level with the features 

below: 
(a)	 There shall be at least 10 slides. 
(b)	 Animation should be used for slide transitions. 
(c)	 Add custom animations like - Entrance, Emphasis, Exit, Motion Path etc. 
(d)	 Add appropriate video clips and audio. 
(e)	 Automatic slide presentation option should be used. 
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UNIT
6

Computer Aided Learning

6.1: Introduction

6.2: Objectives of the Unit

6.3: Computer Aided Learning-Concept Formation & Method Application

6.4: Preparation of Learning-Teaching Materials by using Computer

6.5: Application of the Learning-Teaching Materials

6.6: Application of CAL Materials in the Instructional System

6.7: Project Activities on Preparation of CAL Materials

6.8: Summary

6.9: Unit End Exercises

6.1 Introduction 

“Chalk and talk” method of learning is considered obsolete in the present era. Because the medium 
of learning in this method is chalk and talk which creates an atmosphere of boredom in the classroom 
and students lose interest in school. Present age is the age of information technology. Today computers 
are being used successfully in various fields of technology. The 3Rs of learning are now broadly 
accepted as the 4Rs. There are reading, writing and arithmetic with ROBOT or extremely powerful 
computer is assumed. Currently we use three ‘A’ words in learning. These three ‘A’s are Age, Ability 
and Aptitude. Advancement in technology in the modern age makes it possible to present the educational 
content vividly and attractively through computers. As a result, each student’s interest in the classroom, 
acceptance of the content is increasing and clear concepts are being formed. Based on the application in 
different fields, computer-aided education has various names. For example- 
•	 Computer Aided Learning (CAL) 
•	 Computer Aided Instruction (CAI) 
•	 Computer Based Training (CBT) 
•	 Computer Managed Instruction (CMI) 
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•	 Computer Mediated Education (CME) and 
•	 Computer Assisted Instruction (CAI) 

6.2 Objectives of the Unit

After reading of this unit learners will be able to
•	 Describe the basic concepts and essential methods of computer-aided learning. 
•	 Prepare learning content through computer will be known. 
•	 Understand the application of learning aids to content instruction. 

6.3 Computer Aided Learning-Concept Formation & Method Application 

The concept of CAL is basically born as a result of the increase in the use of programmed instructions 
in computer. Through Computer programmed instruction a large amount of information is stored for 
teaching and that information is also used for teaching when needed. In one word we can say that CAL 
is an instructional tool and it can be used by students to learn different subjects in a specific range of 
instructional methods. 

CAL originates from observing how computer programs work in humans. At earlier experimentation 
was started with the program. These programs were to print computer stored information, evaluate 
answers to multiple choice questions, etc. 

PLATO (Program Logic for Automatic Teaching Operation) was introduced at the University of 
Illinois in 1960. Later, in 1996, Stanford University professor Patrick Sapps introduced computer-based 
tutorials on mathematics and language at the elementary level. Since then, many more CAL programs 
have been developed and implemented and also ncrease the use of computers in education.

There are three methods of computer aided learning; Such as Logo (Logo), Simulation and controlled 
learning. 

Logo: 

A notable method of learning through CAL is called Logo. This method was discovered by two 
professors named Feurzeing and Papart of MIT University. Logo programming language is very easy 
and simple. That is why it is suitable for child education. Children can draw pictures according to the 
instructions of this kind of program. Sometimes children can create their own programs to perform their 
required task as per their need. 

Simulation: 

A higher level of instruction can be provided through CAL’s simulation method than Logo. Two 
categories of this approach are Simulation and Gaming. PLATO and PLATO IV are used here. For 
example, how fruit insects reproduce or grow can be shown through simulation method. It usually takes 
three weeks for flies to reproduce in the laboratory, and more longer time is required if the flies die. In 
this case, the whole process can be demonstrated very quickly in the PLATO program in the simulation 
method. 
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Controlled Learning: 

The third type of CAL is Controlled Learning. Here the student can practice again and again just 
like in the classroom. The teacher only teaches one-time how to use the methods. Students can then 
practice on the computer themselves over and over again and understand where they are going wrong. 
In fact the CAL system is built on tested concepts. As a result, its acceptance in teaching and learning 
methods is high. Some of the concepts on which CAL is prepared are described below: 

•	 4000 or more teachers can use this system simultaneously from different terminals connected to the 
CAL system without any degradation in quality. 

•	 Through CAL, as the student learns, it is recorded in the computer. As a result, the teacher can 
evaluate the student by looking at the recorded part. 

•	 Through CAL, a variety of content can be presented to students in a variety of ways. In this case, 
it should be remembered that what strategy the teacher will adopt, what will be the write ups, what 
will be the pictures; all must be decided in advance. 

6.4 Preparation of Learning-Teaching Materials by using Computer 

The modes or processes used to prepare learning teaching materials for computer aided teaching 
are tutorial mode, drill and practice mode, simulation mode, discovery mode and gaming mode. These 
are discussed below. 

Tutorial mode:  

In this mode a question is given after giving information in small step. Students’ answers are 
analyzed on computer and feedbacks are given as needed. This mode is equivalent to linear programing 
instructions, and both linear and branch methods can be used in this case. Below is an example of how 
to create learning materials using this method. 

Fig. 6.1 Preparation of learning aids in Linear Method 
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Fig. 6.2 Preparation of learning aids in Branch Method 

Drill and practice mode: 

In this method, students are presented with examples of simple to complex concepts or principles, 
in a sequence. Examples are given from easy to difficult concepts mainly to make students master 
through activity. In this case, students are encouraged by reinforcing all the correct answers and try to 
find the reason for the wrong answers and correct them. 

Simulation mode: 

In this mode, the learner is consistently given instruction that matches the real life situation. Such 
content is selected by the computer so that the both time and money will be saved. For example- airplane 
ride, collision between two objects etc. 

Discovery mode: 

Descending procedure is followed in this mode. Generally in this mode the learner is taught through 
trial. and error method. 

Gaming mode: 

In this method, the student is instructed by playing on a specific subject with another person on the 
computer. The quality of learning depends on the nature of the game. For example- spelling games, 
general knowledge games etc. 

6.5 Application of the Learning-Teaching Materials 

Application of CAL Materials in the 21st century has opened new horizons in modern education. 
The preparation and application of learning aids through computer in learning has made learning more 
interesting and effective. The tasks that students or teachers do to prepare these CAL materials can 
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be divided into five categories. These are Lesson Planning, Information Collection, Testing & Test 
Construction, Instruction & Teaching and Evaluation. 

Creating CAL material requires the use of an application software called Powerpoint and to use these 
materials CAL Oriented classrooms are required. The summary of the steps in preparation of CAL 
material are discussed below. 

Lesson Planning: 

At this level the topic selection, what parts of the topic will be covered and how the learning will 
be conducted are planned. 

Information Collection: 

The contents of the CAL are collected by planning at this level. In this case, text and images are 
collected from different sources. 

Testing & Test Construction: 

At this level the collected information is sorted and the selected information or text is written in one 
place and used in the appropriate places. 

Instruction & Teaching: 

At this level, where the text or image is to be used in the learning phase is indicated so that the 
teaching of that content can be accomplished through CAL.

Evaluation: 

A number of questions are asked to assess the learning content at this level. Below a lesson plan 
with examples is shown. 

District Education and Training Organization 

Kalanavgram Burdwan 

Teacher Name : Kamal Roy 

Serial Number : 38 

Academic year : 2013-15 
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Subject: Environmental Education through Computer 
Class : IV 

Unit: The components of the environment are the biota 

Subunit : Different types of animals 
Today’s lesson : -Do- 
Time : 40 minutes 

Tell me how many animals are around us! Someone flies. 
Someone swims. Someone walks on four legs. Someone walks 
on two feet. Some have too many legs. Someone walks into the 
chest again. Someone lives in the water. Some are quite happy 
underground. All animals have the right to live. They have 
different colors. They are each beautiful in their own place. 
They find their own place. Collects food. Gives birth to new 
creatures. There are also several animals that cannot be seen 
with the naked eye. This is how we all live together in the same 
environment.



94



95



96

6.6 Application of CAL Materials in the Instructional System 

Actually CAL or Computer Aided Learning is a system of coordinating computer hardware, software 
and curriculum that can be used in all subjects and at all levels. Here is a discussion on how to teach 
reading at the elementary level. In this case, the student will sit in front of the computer monitor and 
use the keyboard or mouse if necessary. This method basically has three levels first level, second level 
and third level. 

First level: 

At this level, first a character is shown on the screen by the computer. Now the student is asked with 
the help of recorded voice to identify the letter and to show the correct letter with the light-pen on the 
monitor. In this way one by one letters are shown and the student is asked to identify the correct letter. 
This method is shown with the help of a figure below. 

Fig. 6.3 First layer 

Second level: 

Once the characters in the first level are introduced, the second level begins. Here some pairs of 
words are given on the screen and asked to mark them with some associated letters on the monitor. This 
method is shown with the help of figure below. 

Fig 6.4 Second layer 

Third level: 

At this level the monitor has multiple associated letters and numbers on one side and multiple 
associated letters on the other side. It is said to identify those words that have complete similarity. 
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Man			   Can
Cam			   Cat
Man			   Can
00				    0

Fig. 6.5 Third layer

In the monitor the words Man, Cam, Can, 00 are on one side and the words Can, Cat, man, O on the 
other side. The student will identify the words that have complete similarity. In this case, the word Can 
is completely similar. Then the student will gradually be able to pronounce meaningful words. The 
computer recorded voice will help the student if the answer is wrong and praise if it is correct. 

6.6.1 Role of Teacher in CAL Process: 

If the student makes a mistake in learning through CAL method, the computer instructs the teacher 
and the teacher tries to teach the student through personal assistance. In this case, if many students face 
the same problem, the teacher tries to modify the program again. It can be said that the CAL method does 
not minimize the role of the teacher, rather utilizes their skills to create a better learning environment. 
Currently, CAL is highly standardized in education using “Intelligent Tutoring” methods. To prepare a 
complete CAL system requires a few skilled people. They are highlighted below: 

•	 Computer Engineer - Responsible to provide all support related to computer hardware and software 
for CAL system preparation. 

•	 Text writer - usually a teacher does this. 

•	 System Operator - He acts as a mediator between the system and the student in all CAL arrangements. 

6.7 Project Activities on Preparation of CAL Material 

The term project was first used by PR Richardson in 1900. While defining project in 1908, Dr. 
Stevenson said project is a problem-solvic task which is attempted to be solved in a natural environment. 
In short, al project is a purposeful problem-solving task to be accomplished through active and 
spontaneous behavior in a normal-life based social environment. Teaching through CAL is a project-
based activity that engages students. in learning, sparks interest and increases the acceptance of the 
contents. In this project based work students are able to make the project real through four levels. These 
levels are discussed below: 

(a)	 Objective determination level: 

At this level, the teacher discusses the content with the students and identifies its characteristics 
or purposes and explains to the students how it will be used. Students can learn about what specific 
knowledge they will gain by making this project. 
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(b)	 Planning level: 

After the objective of the content is determined in the first level, how to solve the problem with the 
help of the teacher is planned in this second level. How much content will be covered, how the work will 
be divided into parts, what kind of data will be collected, are also planned at this level. 

(c)	 Performance level: 

The content planned in the second level is implemented in this level. Students, with the help of the 
teacher, use their own judgment to complete the tasks of creating learning content through computers, 
using technology. Power point software, web tools, sound recording etc. are used in this case. Teacher 
monitors students’ work at this level. 

(d)	 Assessment level: 

At this level, the teacher and students discuss the results of the task after it’s completion and the 
teacher evaluates the students’ work. 

How learning content is prepared is explained with the help of example. 

Subject: Environmental Education through Computer 

Class: IV 

Unit: Clothe 

Sub-Unit: Change of clothes with seasons

Determine Objectives: 

1.	 Being aware of what we wear as the seasons change. 

2.	 Know which clothing dries quickly during monsoons. 

3.	 To gain knowledge about different clothes in different seasons. 

Plan: 

Students will divide into groups and complete the task with the help of the teacher. 

First team: 	  will collect seasonal data. 
Second group:	 will collect photos related to seasons. 
Third party:	  will coordinate this information and images.

Actions: 

Students will create CAL materials using various technologies (Power Point of MS-Office, 
Multimedia Web etc.) through computer with information or text and images collected at planning 
level. In this case the teacher will monitor and guide their work. 
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Assessment: 

At this level the student is assessed by preparing some fill-in-the-blank questions, multiple choice 
questions, etc. to make the CAL content more interesting and useful for learning. All the topics are 
presented with examples below. 

District Education and Training Organization 
Kalanavgram, Burdwan 

Trainee Teacher Name: Shambhunath Ganguly 

Serial Number: 42 

Academic year: 2013-15

Topic: 

Education of our environment through computer 

Class: IV 

Unit : Clothing 

Sub-Unit : Change of clothing with change of seasons 

Today’s lesson : -Do-

Time: 40 minutes 
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Topic: 

Education of our environment through computer 

Class: IV 

Unit: Clothing 

Sub-Unit : Change of clothing with change of seasons 

Today’s lesson: -Do- 

Time: 40 minutes
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Change of Seasons Change of clothes 

The clothes that people wear during work, they don’t wear at other times. Nobody 
wears school uniform at home. Everybody wear different clothes when they go 
outside. 

During the winter, however, different colored sweaters which they have can be worn 
at school. Munni wears a floral sweater. Babai comes wearing a open chest coarse 
sweeter. 

During winter, many people wear different types of cloaks. Some are of coarse wool. 
Some are of very fine wool. On watching it can’t realize that they are oven with wool. 

Great-grandmother said, very few of them had sweaters when they were children. 
There was a doctor. He wore court and pants like gentlemen. Other people in the 
neighborhood used to wear cloaks in winter. Some wore two or three clothes. 

Baisakhi said to Miss - Didi, now more sweaters are available than before. 
Grandmother said-

Sutana said - From what Sympathetic trolls are made of. 

Didi said - from mineral oil. 

She said again the raincoat that you wear during the rainy season is synthetic. Many 
people wear synthetic sarees during monsoons. Dries quickly, does not scratch. They 
are also made from that type of oil 

Wasim said - cotton clothes are good for wearing in summer, isn’t it? 

- You are right. Then it is learned about the various materials for making clothes. Do 
you understand which one to wear in which season?
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Answer the following questions appropriately 

A. �What clothes do we wear in winter?
Answer:- Sweaters, sheets etc. 

B. �What is synthetic wool made from?
Answer :- From mineral oil. 

C. �What do we wear during the rainy season? 
Ans:- Monsoon, Sympathetic cloth etc. 

Answer the Questions in Groups 

Q1.	Why is it better to wear a synthetic saree during the rainy season? 
Ans. - dries quickly, does not wrinkle when cut. 

Q2.	What is the English equivalent word of ‘season’ and ‘clothing’? 
Ans. Season - TIME clothes - DRESS.

Answer the Questions in Groups 

Q1.	Why is it better to wear a synthetic saree during the rainy season? 
Ans. - dries quickly, does not wrinkle when cut. 

Q2.	What is the English equivalent word of ‘season’ and ‘clothing’? 
Ans. Season - TIME clothes - DRESS. 
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Answer in your own words (discussing in group)

A.	 What clothes are good to wear during the summer?

B.	 Fill in the chart below- 
	 Name of Dress Used in Season Why it is used �Picture of the 

dress 
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C. In which season we use umbrella? 

D. In which season Cloaks are used? (summer/winter) 

E. In which season we use Rain Coat?
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6.8 Summary 
•	 Computer-mediated learning has various names based on its application in different areas of 

computer-mediated learning management. Like CAL, CAI, CMI, CBT etc. 
•	 The use of CALS has expanded since the introduction of program learning. 
•	 Basically three methods are used in computer aided learning process logos, simulation and controlled 

learning. 
•	 The modes used to create learning materials through CAL are Tutorial mode, drills and Practice 

Mode, Simulation Mode, Discovery Mode and Gaming Mode. 
•	 It must be remembered that a computer or any device can never take the place of a teacher. 

6.9 Unit End Exercises 
(1)	 What does CAL mean? 
(2)	 What are the three methods of learning by CAL? Discuss in detail. 
(3)	 Discuss in detail the modes used to prepare learning aids for computer aided learning. 
(4)	 What are the differences between CAL and CAI? 

Project Work: 
(1)	 Prepare a CAL material (minimum 8 slides) on Bengali language at upper-elementary level. 
(2)	 Prepare a CAL material on science at upper elementary level (at least 8 slides). 
(3)	 Prepare a CAL material on cultural activities. 
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UNIT
7

Web-based Learning 

7.1: Introduction

7.2: Objectives of the Unit

7.3: World Wide Web (WWW)

7.3.1: Conceptual Frame Work of WWW

7.4: Fundamentals of Internet

7.4.1: Concept of Some Fundamentals used in Internet

7.5: Uses of Internet

7.5.1: Downloading Information from Internet & using the same for the development of Children

7.5.2: Uses of Web in Teaching-Learning System

7.5.3: Importance of Email in Communication and Teaching-Learning System

7.5.4: Creating Password for Net Work Security

7.6: Summary

7.7: Unit End Exercises

7.1 Introduction 

The present age is the age of information technology. The use of information technology is gradually 
improving people’s lifestyles. And the World Wide Web has played the biggest role in the use of this 
information technology. The World Wide Web is the most widely used, popular and essential of the 
Internet services or applications. World Wide Web is better known as WWW in short. The architectural 
framework for accessing the aggregated information of millions of computers connected to the Internet 
is the WWW, also known simply as “The Web”. In short “The Web” is the collection of millions of files 
stored on millions of computers spread across the globe. These files can contain text, picture, video, 
sound and various other programs. 
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Web-based learning has played a major role in today’s information technology era. And this web-
based learning has had the greatest impact in the field of education. There has been a change in the 
education system, curriculum and content of education. With the help of the web, students can access 
a vast amount of information and online systems have also been introduced for examinations. The use 
of CAL, CAI, CMI etc. has increased to a great extent. At the root of all this is the use of the web. As 
a result of the use of the Web, on the one hand, students can learn very easily and quickly, on the other 
hand, that education is permanent. 

7.2 Objectives of the Unit

After reading of this unit learners will be able to-
•	 Get an idea about the World Wide Web (WWW). 
•	 Construct the idea of basics of Internet and its usage will be known. 
•	 Demonstrate use of the web in the learning process. 
•	 Define information exchange and use of e-mail can be learned. 
•	 Acquire the knowledge about passwords and their usage can be gained. 

7.3 World Wide Web (WWW)

In 1989, a physicist named Tim Burns Lee gave the idea of WWW and is called the father of WWW. 
Then in 1991 WWW was first implemented experimentally. The WWW works through hypertext and 
hypermedia. The first web browser was introduced in 1993. These web browsers are-Internet Explorer, 
Google Chrome, Mozilla Firefox, etc. 

WWW is a graphical Internet service. WWW uses Hypertext Transfer Protocol (http) to link or 
connect one information to another. The word web is analogous to spider web. The WWW is spread 
like a spider web all over the world and these connections are made through different Servers. That is, 
WWW is a series of Servers where the servers have an interconnection among themselves. The host 
computer user can view or use information or data, graphics, audio, video etc. on his own computer 
through his own ISP server by browsing and can also download or upload the data if necessary. 

7.3.1: Conceptual Frame Work of WWW 

From the previous discussion some idea about WWW is obtained. Here’s a look at how the WWW 
works. As already known it is part of Internet and it actually works through Request and Reply method. 
Here the user sends the required request to his current server and the server gives a response in terms of 
that request. In this case, after receiving the required response from the server, the connection between 
the server and the client is disconnected. The protocol through which this Request and Reply method of 
WWW is organized, is called HTTP (Hypertext Transfer Protocol). 

It is explained with an example. Let’s say a user types www.google.com in a web browser and 
presses enter. Here WWW.google.com is a URL. The full name of the URL is Uniform Resource Locator 
In this case, how Request → Reply is organized is discussed below: 
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	 (i)	 Web receives user-entered URL. 
	 (ii)	 Then the browser wants to know IP address of specified URL i.e. www.google.com from DNS 

(Domain Name Server) 
	 (iii)	 After receiving the required request from the browser, DNS sends the specified IP address as a 

reply to the browser. 
	 (iv)	 Then the browser connects to that address through TCP (Transmission Control Protocol). 
	 (v)	 Browser sends GET command to server. 
	 (vi)	 The server sends the required response to the browser. 
	(vii)	 The TCP connection with the browser is now disconnected. 
	(viii)	Now the browser displays the information contained in the page. 

Fig 7.1 Displaying information through a web browser

The image above shows how the information is displayed within the page by the browser. 

7.4 Fundamentals of Internet 

When two or more machines are connected together to establish mutual connections and exchange 
information, the system is called a network. When the network is connected through gateways and 
facilitates worldwide communication services, then that system is called Internetwork or Internet. 

The United States Department of Defense created ARPANET (Advanced Research Projects Agency 
Network) in 1969 as a courtesy to the government. This ARPANET is called the first internet. Then in 
1970 Networking Group or NWG created NCP (Network Communication Protocol), because many 
computers were connected to this network system every day. The first e-mail communication system 
was introduced in 1972. In 1973, the ARPANET began to spread around the world, starting with the 
expansion of the network from Norway to England. At this time, FTP (File Transfer Protocol) was used 
on the Internet to exchange the information. Later in 1983, TCP/IP (Transmission Control Protocol / 
Internet Protocol) was recognized as the official protocol for data exchange on the Internet. The DNS 
system started in 1984 and by 1990, 200 networks and 2,00,000 computers were connected to the 
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Internet. Then the World Wide Web was created for public use. It may be mentioned that a common form 
of Internet is WAN (Wide Area Network), the collection of LANS (Local Area Network) connected by 
it is shown below with the help of diagram: 

Fig 7.2 A typical Internet connection 

Various information is available on various web pages of the internet website and any interested person 
or organization connected to this internet can access (i.e. read) that information and download it to their 
machine if necessary. 

7.4.1 Concept of Some Fundamental Concepts Used in Internet 

If the user wants to get internet service through computer then some hardware and software must be 
present in the computer. Incidentally, all the organizations through which Internet services are available 
are called Internet Service Provider (ISP). ISP provides internet service through router. All the computers 
that are used to collect any information are called servers. 

All the hardware or software required to get internet service are discussed below: 

Modem: 

The word Modem is the abbreviation of Modulator-Demodulator. In fact, 
when a computer is connected to another computer through the Internet, the 
connection is made through a telephone line. But the difficulty is that computers 
work through digital signals, and information exchange through telephone is 
done through analog i.e. PSTN (Public Switched Telephone Network) method. 
These two methods are completely different. Therefore, to bridge these two, 
a special device is required through which analog signals can be transformed 
to digital and vice-versa. Modem is one such electronic device whose main function is to convert the 
signal from the telephone (analog computer load) into digital signal and convert the computer’s digital 
signal into analog. Modems are generally of two types: external and internal. The external modem is 
placed outside of the computer system thus if required, it can be used from one computer to another 
after disconnecting it. But the internal modem is placed inside the computer system unit. The speed of 
the modem depends on how much data or information can be sent per second. 

Fig. 7.3 Modem
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Computer: 

A computer is the first requirement to get internet service. A computer needs a higher frequency 
processor and more RAM for better performance. 

The required software: 

It is often required a modem and its driver software to be installed to establish the connection 
with the computer system and to browse the internet a browser or a search engine, which is a software 
program is also required to be installed. 

Browser: 

A browser is a special type of software program that can be used to easily search for information 
on the Internet. For example, while working on a specific topic, going to another web page on another 
topic, returning to the previous topic or page, etc., can be done with the help of the browser. The main 
function of the browser is to provide the source of information to the user. When the user accesses a 
Uniform Resource Locator (URL) through the browser, the browser starts working. For example let’s 
say a URL is http://scernwb.org. This URL has two parts, the first part is http and the second part is 
scertwb.org separated by :// signs. The first part indicates that information can only be collected using 
Hypertext Transfer Protocol (HTTP). Since the Internet is a hyper media, Hyper Text Markup Language 
(HTML) is used here. Therefore, in order to exchange information written in hypertext format, web 
browsers must use the Hypertext transfer protocol (http). CSS (Cascading Style Sheets) is another 
protocol that allows web browsers to use graphical interfaces on the web. Such browsers are Microsoft 
Internet Explorer, Mozilla Firefox, and Opera etc. The second part i.e. scertwb.org refers to the domain 
name. 

Search engine: 

Search engine is a tool used to find information available on the WWW. After searching, the data 
is presented as a list called hits. The first search engine was created by ‘Alan Emtage’ in 1993 and the 
name of this search engine was ‘Archie’. Then came Gopher Search Erin in 1991. Currently there are 
more types of search engines. Some of them are Netscape, yahoo, Google, MSN etc. Search engines. 
work in three steps - Web Indexing, Crawling and Searching. 

Search engines collect and store web page information and then deliver this information to the 
user through html. Web pages are collected using Web crawler. Sometimes these crawlers are called 
‘spiders’. Indexing is the process of analyzing page by page to determine how to index or list. When a 
user searches for information in a search engine, the search engine analyzes the information gathered in 
its index and creates a list and gives it to the user. But every search engine has its own characteristics by 
which it decides which information is more important and which is less important. 

Browsing or Surfing: 

The word browsing or surfing means to search or search. Searching for data or information using 
the internet is net surfing. When a browser is instructed by a word or gesture, the browser lists the 
information. Retrieving information on the internet with the help of this list is net surfing. Surfing can 
be done through search engines like Internet Explorer, Google Chrome, and Mozilla Firefox etc. 
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7.5 Uses of Internet 

Nowadays, the use of internet is increasing in almost every aspect of life. The widespread use of the 
Internet in various fields of social life has brought many benefits in various activities. Internet usages 
are discussed below. 

In Education: 

The use of internet in education has brought a revolutionary change. Information required for 
various educational and research activities can be collected through the internet. Information on various 
topics, articles, research papers, etc. can be easily found by searching various websites. The internet has 
brought information about admission in various educational institutions in abroad within our reach. Not 
only that, in the case of online admission, form fill up, form submission etc. can be done very easily 
and quickly through internet at home. Students can participate in various competitive exams (like GRE, 
CAT) and know the exam results using internet. 

In Business: 

Almost all things according to our choice can be purchased from home using internet. It is possible 
to buy and sell goods from any part of the world using the internet. This type of business is known 
as e- commerce. Internet is a helpful medium for booking train and air tickets and booking a hotel 
room. Insurance premiums, electric bills, telephone bills etc. can be deposited through the internet from 
the comfort of your home. Many banking tasks can be done from the comfort of home with internet 
banking. Various business organizations can advertise their various products through web pages on their 
own websites to promote their business. 

As a medium of communication: 

Internet is a fast, cheap and popular medium of communication. Information, messages, files, etc. 
can be exchanged from one end of the world to the other in a very short time and at low cost through 
e-mail. In this case, both sender and recipient need to have an e-mail address. Another easy way to 
communicate through the Internet is instant messaging. Instant messaging is a service on the Internet 
through which a user can establish real time communication with one or more users. In this case, not 
only text messages, but pictures, videos, etc. can be exchanged and voice or video chatting can be 
done. WhatsApp is a popular instant messenger. Through social networks (like Twitter, Facebook) on 
the internet, you can communicate with friends and relatives; you can also build new friendships and 
express your own opinion. Apart from this, other means of communication with the help of internet are 
Internet Telephony, Web conferencing etc. 

In entertainment: 

With the passage of time, the Internet has emerged as an essential medium of entertainment. Online 
games, listening to music, watching movies, etc. are available on the Internet. There are different types 
of websites. From where you can download songs, videos, games etc. for free or at little cost. Internet 
versions of various books can be read online or in many cases can be downloaded. Now it becomes 
possible to watch their various programs from the sites of various TV channels. 
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In government work: 

The use of internet has played a very important role in the work of various government offices. 
Almost all the government departments have their own websites from where information related to the 
activities of the respective departments, progress of various government works etc. can be obtained at 
home. As a result of this, the transparency of government activities has also increased and common 
people are also getting to know about various government facilities. For example, applying for a 
passport, submitting income tax returns can all be done very easily and quickly through the Internet. 
Also, various government agencies are able to coordinate their activities more by sharing information 
with each other through the Internet. 

7.5.1 Downloading Information from Internet  & using the same for the development of Children 

Today’s era is the era of information technology. Today the role of information in all aspects of life is 
immense. The advancement of information technology and the widespread use of the Internet have made 
information retrieval and its use very easy. Like other fields, the use of internet in education especially 
in child education and child development is very significant. A huge amount of information is at our 
fingertips today through the internet. Collecting information from this vast repository of information 
and using it at all levels of teaching and learning has made it possible to easily overcome the limitations 
of textbooks. As a result, it has become easier for the teacher to answer the various questions of the 
children’s minds and to curb their curiosity about various subjects. And all of these play an important 
role in mental and character formation of a child. However, if the information collected from the internet 
is properly analyzed and served to the student with examples and appropriate. explanations, the content 
will become more understandable and it is the sole responsibility of a teacher. 

Transferring the necessary information from the Internet to the user’s computer is called downloading. 
All the information that is downloaded through the internet should be properly saved for future use. The 
method of downloading information from the Internet is briefly discussed below: 
•	 First, Internet Explorer, Mozilla Firefox, Google Chrome or any such web browser should be 

opened. 
•	 If you know the address of the website from which information is to be collected, type the address 

of that website in the address box of the web browser and press the Enter key or click the Go button. 
Only then the web site will be opened and the required information can be collected from there. 

•	 If the exact address of the website or portal is not known, Google or any such search engine must 
be taken. 

For example, suppose a user wants to know which teacher education institutes are recognized 
by the National Council for Teacher Education or NCTE in West Bengal. But the user doesn’t know 
the web address. In this case, by opening a web browser, type the address of a search engine, say 
Google’s address i.e. www.google.com and press Enter key; Google’s home page will be opened. Type 
National Council for Teacher Education in the search box and click the google search button or press 
Enter key. Immediately a list will be appeared on the computer screen is containing the first entry as 
NCTE: National Council for Teacher Education along with its web address www.nete-india.org will 
appear. Clicking the mouse on this name will open the website of NCTE. Now, if you click on the 
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link “Recognized Institutes” from this website, this page of Recognized Institutions will open. On this 
web page, if you click on the “I Agree” link of the Recognized Institution’s List column included in 
the Eastern Regional Committee, you will see the List of Recognized Teacher Education Institutions 
(Eastern Region). The page will open. Here, if you click the mouse on West Bengal among the states 
included in the Eastern Region, another page will open with the names of Teacher Education Courses of 
D.EL.Ed., B.Ed., M.Ed., B.P.Ed and M.P.Ed of West Bengal. Now if you click on D.EL.Ed, you will get 
information regarding the name and recognition of NCTE recognized DELEd colleges in West Bengal. 

7.5.2 Uses of Web in Teaching Learning System 

The use of Web in education is not only popular but has become a necessity over many areas. The 
web has brought about a revolution in information gathering, information sharing and information using 
that has added a new dimension to teaching-learning. In other words, the qualitative and quantitative 
excellence has increased manifold as a result of the use of the web in teaching - learning. One of the most 
important features of the Web is its use of multimedia and hypertext. Multimedia in the presentation of 
information hypertext, hyperlinks and automatic search have made the web more multimedia dependent. 
As much as a subject is interesting to the student in the traditional book-based education system, when 
the same subject is presented through multimedia i.e. text, images, animation, sound, etc., it becomes 
much more interesting and acceptable to the students. The web is the only alternative in delivering that 
education to any person anywhere in the world. 

Traditional lecture method teaching in schools, colleges or universities cannot fully meet the 
educational needs of students. Universal participation of students at all levels in this system is not 
universally feasible. A student can find useful information for his/her reading or research from the web, 
similarly the web may become very helpful as a medium of distance education. Distance education 
institutes can deliver the syllabus, notes, lectures etc. of their various courses to the students through 
their respective websites. If there is an e-learning system on the website of an educational institution, 
then students can participate in online lectures and web based training or WBT. Based on this system, 
virtual universities have been created in different countries of the world. In a virtual university, students 
do not need to physically attend a class. Off-campus teaching has changed into virtual teaching today 
with the combination of multimedia, hypermedia and information technology. In virtual class mutual 
exchange of opinions and action-reaction between teacher-student is possible very quickly. 

Currently, teachers or students can use different OER or Open Educational Resources for their own 
needs, OER are different resources related to teaching, learning and research that are available from the 
web for free and can be used and shared as and when needed. In this context, it may be mentioned that 
the National Repository of Open Educational Resources or NROER created by the joint initiative of the 
Central Institute of Educational Technology (CIET), NCERT and the Human Resource Development 
Department of the Government of India was launched on 13th August 2013. This Repository contains 
resources on various subjects from primary to higher secondary level in the field of school education. 
Initially this information is available in English and Hindi. However, this resource will soon be available 
in various regional languages as well. Moreover, it is planned to create Repository at the state level as 
well which will be linked with the National Repository. The web address of NROER is www.nroer.
in. Another important contribution of the web is the news group. News group is an Internet discussion 
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forum where members can exchange messages on any topic. There are thousands of newsgroups on 
technical and non-technical topics, where members can participate in discussions on any topic. Also, 
a member of the newsgroup can read or download articles on various topics and can also post his own 
articles. Through Newsgroup a member can not only acquire knowledge on various topics but also can 
give his opinion on various topics. One of the most popular applications of computer networking is the 
worldwide system known as USENET.

Teaching and learning activities that teachers can do using various web resources are- 
(a)	 Curriculum development. 
(b)	 Lesson planning. 
(c)	 Constructing and implementing aspirations. 
(d)	 Assessing. 
(e)	 Instruction and Teaching. 

7.5.3 Importance of e-mail in Communication and Teaching Learning System 

E-mail or electronic mail is one of the most important and widely used Internet services. E-mail is 
an electronic message sent from one computer to another using the Internet. In more detail it can be said 
that through this e-mail service it is possible to exchange information of various types between person 
to person or person to organization or organization to person or organization to organization over the 
Internet. This information can be text, images, audio and video. Geographical distance is no barrier to e- 
mail exchange. No matter where the sender and receiver are in the world, the sender’s message reaches 
the receiver very quickly. In this case, only the computer of the sender and recipient should be connected 
to the Internet and both should have an e-mail address. Advantages and disadvantages of using e-mail 
are described below. 

Advantages of using e-mail: 
(a)	 Sending information through e-mail is very easy and can be transmitted very quickly. 
(b)	 The cost of sending e-mail is very low. 
(c)	 It is immediately known whether the information sent has reached the recipient correctly, and if not, 

it can be re-sent. 
(d)	 The recipient can read the letter and send a reply by opening his mail box wherever he is. 
(e)	 Same message can be sent simultaneously to more than one person. In that case there is no need to 

write again and again, only the writing of e-mail address is required. 
(f)	 E-mail messages are much more secure due to password protection. Anyone sitting on the computer 

can’t open other’s mail box. 
(g)	 E-mails can be exchanged at any time of the day or night. 
(h)	 An e-mail message can be sent as a text file, scanned paper, image or any audio or video attachment. 
(j)	 The message is stored in the recipient’s mailbox even if the recipient’s computer is disconnected 

from the Internet. Therefore, while sending the mail, the sender does not have to worry whether the 
recipient is connected to the Internet at that moment or not. 
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(j)	 E-mails can be stored in the mail box (inbox) for a long time. 
(k)	 Print out of any e-mail can be taken as and when required. 

Disadvantages of using e-mail: 
(a)	 It is almost impossible to send very large e-mail messages or large volumes of data as attachments. 
(b)	 The speed of e-mail transmission may be very slow if there is a problem with the network system. 
(c)	 User’s computer is infected by various computer viruses while exchanging information through e- 

mail (affected) and may damage the computer system. 
(d)	 If you do not log out of your e-mail account, someone else may use it for malicious purposes. 

 Email Address 

Sending or receiving e-mail requires a specific address or addresses, just as an address is required for 
sending general correspondence. This is called e-mail address or e-mail Id in short. There are many 
websites where e-mail Id can be generated, like www.yahoo.com, www.rediffmail.com etc. Using these 
websites one can generate e-mail Id free of cost. It is worth noting here that every letter of e-mail Id 
should be English lower case letter. The e-mail Id is a unique address i.e. more than one person cannot 
have the same e-mail Id. There are two parts of a complete e-mail Id, namely- 
	 (i)	 User name and 
	 (ii)	 Domain name 

The above two sections are separated by ‘@’ symbol. User name indicates the identity of the person or 
organization who is the sender or recipient of the mail. Username must start with a letter and can contain 
any number, period and some special characters, but no comma or space can be used in username. The 
domain name refers to the computer system where the user’s account is. In other words it is the e-mail 
service provider identifier Id. For example say roy_abir 1975@rediffmail.com is an e-mail Id where 
roy_abir 1975 is the username, rediffmail.com is the domain name and com is the nature of the domain. 
Sometimes the domain name can be followed by a dot (.) followed by the country code, eg arka 2010@
yahoo.co.in/ 

 Buttons / Options used in E-mail 

Below is an explanation of the buttons that will be visible on opening the e-mail page and what those 
buttons are used for: 
•	 New Message/Write/Compose: To write a new mail, click on New Message/New Mail/Write 

Compose etc. from the menu or toolbar of the e-mail software, a window like the image below will 
open. Here the user can write the content of the mail as per his requirement. 



116

Fig. 7.4 E-mail page or window
•	 TO: Recipient’s e-mail address is to be entered in this field. 
•	 CC: The whole word is Carbon Copy. To send a mail to multiple recipients, the main recipient’s 

e-mail Id is written in the TO-box and the e-mail Ids of the rest are written in the CC-box separated 
by commas. 

•	 BCC: The full word of this word is Blind Carbon Copy. Here also multiple recipient e-mail Id is 
written with a comma. But while in CC the recipient can see the addresses of other people who have 
sent the same e-mail, but in BCC the recipient can see only his own mail address. 

•	 Subject: In this cell, the content of the e-mail message is briefly written. 
•	 Attachment: If any other text file, image, scanned document etc. is attached to the e-mail and sent 

to him attachment is called and use the Attachment Option to send such an attachment is sent. 
•	 Send: Clicking this button after writing the mail sends the e-mail to the recipient’s address. 
•	 Inbox: All the mails received by a recipient are stored in this place in the form of a list or lists.
•	 Outbox : If the internet connection is disconnected for some reason at the time of sending an 

e-mail, it is deposited in the outbox is Mails are re-sent from outbox when internet connection is up. 
•	 Sent Item: A copy of all the mails sent to the recipient is deposited in this box. 
•	 Trash: All e-mails deleted from Inbox, Outbox or Sent Item are stored in this box. These mails if 

needed Can be recovered from Trash. 
•	 Reply: If you need to reply to an e-mail, then open that mail from the inbox and click on the Reply 

button to get a space to write the reply with that mail. Then type the answer and click the send 
button to mail the answer goes to recipient. 

•	 Forward: Open an email when you need to send it to someone else in the same state as it arrived. 
Click on the Forward button. Then enter recipient’s e-mail Id in ‘To’ field and click on send button, 
the mail will be forwarded to the recipient’s address. 
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Process of Sending E-mail: 

The sequential steps of sending e-mail through the Internet are—
(a)	 The computer must be connected to the Internet. 
(b)	 Open certain browsers like Google Chrome or Internet Explorer or Mozilla Firebox. 
(c)	 In the address box of the browser (Address box) write the specific website, let’s say WWW.gmail.

com and press Enter. 
(d)	 Now enter the e-mail Id in the first blank text box of the previous image and the valid password in 

the blank box below and click on the sign in button to open the e-mail account. 
(e)	 Then click on the COMPOSE button on the resulting screen. 
(f)	 Enter recipient’s e-mail Id in TO field here. If you want to send a copy of the same mail to another 

person, enter their e-mail Ids in the CC and BCC fields. Then type the subject of the letter in the 
subject field below and the description of the letter in the blank space below. 

(g)	 If you want to attach a file to the e-mail, click on the Attachment button and select the file to be 
attached from the Choose File dialog box. Gmail will automatically start uploading the file and 
when the upload is complete, the name of the file will appear in the text box below. 

(h)	 After clicking on the send button below, the e-mail will reach the recipient. 

Reading Email : 

To read an email follow the steps below: 
(a)	 Login to the e-mail account with the help of e-mail Id and Password and click on Inbox. A list of 

mails stored in Inbox will appear. 
(b)	 Clicking on the mail to be viewed will open the mail. If there is any attachment with this mail, then 

it will appear to the left of the mail header in the form of a paper clip. 

 Role of e-mail in teaching-learning system: 

The importance of e-mail in teaching-learning process is very high. It is described in below- 
(a)	 Information required for teaching learning can be collected through e-mail. Requesting the necessary 

information by sending an e-mail to the information provider can send it through e-mail. 

(b)	 Research findings can be shared. 

(c)	 Through e-mail, teachers and students can discuss any topic outside the classroom at any time. 

(d)	 If the student faces any problem in reading, he/she can contact the teacher through e-mail to report 
the problem and get the solution of the problem in the e-mail received from the teacher. 

(e)	 Students can get new direction regarding their research by establishing e-mail communication with 
professors of different universities abroad. 

(f)	 Students can become more active and constructive in learning through internet and e-mail. 
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(g)	 Barriers that do not exist in Internet and e-mail education are class size, pace of student learning, 
timed lessons in the classroom, lack of required information, etc. 

7.5.4 Creating Password for Net Work Security 

The use of passwords is considered to be the most effective way to properly protect information on 
all computers on a network. Passwords of individuals or organizations on the network are very important 
to prevent any other person or organization from collecting, destroying or misusing the information of 
an individual or organization without permission. Keeping the personal information of its clients secure 
is of utmost importance to any organization. There is no substitute for password protection when sharing 
information over a network. A password is a security system where a special code ensures the security 
of a data store. That is, in this case, if you want to access the database, you have to unlock it using the 
specific code by which the database is locked. Only valid user will know this code or password. All 
users who have e-mail, Facebook etc. accounts have a password to access their accounts. When an 
ATM card user withdraws money from his account using the ATM card he has to input a PIN (Personal 
Identification Number) which is a password. If this password is correct then the person is allowed to 
withdraw money from the account. Any other unscrupulous person knowing this password code can 
withdraw money from the ATM card holder’s account and make him destitute. So the importance of 
having the right password and keeping it secure is immense. Depending on what type of code is used 
as a password, passwords can be divided into two categories, such as weak password strong password! 

Weak Password: All passwords that can be easily guessed are called weak passwords. Using this type 
of password, the security of any sensitive information cannot be guaranteed. Many people write down 
their passwords because they can’t remember them. As a result all these passwords have the possibility 
of falling into other hands, which is why such passwords are also classified as weak passwords. Many 
users use family name, date of birth etc. as passwords to remember. But in this case, it is necessary 
to know that all the dishonest people or organizations who work to break this password keep all the 
personal information of the user in their database. So this type of password also falls in the weaker 
category. 

Strong Password: Passwords that have a large number of characters and are difficult to guess, i.e. 
passwords that use complex signals are called strong passwords. Cracking such passwords is difficult 
and time-consuming due to their long length and complex signals. In general, the characteristics that a 
strong password needs to have are—
(a)	 Length preferably at least 4 to 15 characters. 
(b)	 Such passwords consist of upper and lower case letters, numbers (0-9) and special characters!, @, 

#. S, %, etc.) can be made in combination. 
(c)	 The password must use something known only to the user, not any personal information. 
(d)	 The password should not contain any consecutive alphabets or numbers. 
(e)	 The password must be something that cannot be disclosed to anyone else. 
(f)	 Passwords must use something that can never be written down directly anywhere. 
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7.6 Summary
•	 The World Wide Web (WWW) is the architectural frame work for accessing information from 

millions of computers connected to the Internet. Its father is Halen Tim Banners Lee. 
•	 A system when two or more machines are connected together to establish mutual connections and 

exchange information is called a network. 
•	 When the network is connected through gateways and facilitates global communication services, 

then that system is called Internet work or Internet for short. 
•	 A browser is a special type of software program that makes it easy to search for information over 

the Internet can be done Some popular web browsers are Internet Explorer, Mozilla Fire Fox etc. 
•	 A search engine is a tool used to search the WWW. Some of the popular search engines are Google, 

MSN, Yahoo etc. 
•	 Email is an electronic message sent from one computer to another using the Internet. A complete 

e- mail Id consists of two parts, i.e. username and domain. 
•	 Password is a security system where the security of information is ensured by means of special 

codes. Passwords can be divided into two types depending on the type of code used in the password. 
These are weak password and strong password. 

7.7 Unit End Exercises 
	 1)	 What does WWW mean? 
	 2)	 Mention the advantages of WWW. 
	 3)	 Write how search engines work. 
	 4)	 What is meant by browsing? 
	 5)	 What are the hardware and software required for internet service? 
	 6)	 Discuss the uses of internet. 
	 7)	 Describe the method of downloading information through internet. 
	 8)	 Discuss in detail the use of web in education and learning. 
	 9)	 What is e-mail? Mention the various advantages of e-mail. 
	 10)	 What is an e-mail address? Discuss with examples. 
	 11)	 Write about the importance of e-mail in teaching learning. 
	 12)	 Discuss the role of passwords in network security. 
	 13)	 Write the complete form: 
		  WWW, TCP/IP, ISP, DNS, HTML, HTTP, E-mail, URL, FTP, SMTP POP 
	 14)	 Write a short note on: 
		  Internet History, URL, E-mail, Domain Name, Web Browser. 
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Project Work: 
(1)	 Browse the website of West Bengal Board of Primary Education and download the syllabus of 

D.EL.Ed from there. 
(2)	 Browse the web site of State Council of Educational Research and Training, West Bengal and 

collect information about D.I.E.Ts in West Bengal (e.g. number of DILE.TS, location, infrastructure, 
activities etc.). 

(3)	 Create an e-mail account. 
(4)	 Send mail with an attachment to a friend from own e-mail account. 
(5)	 Search a favorite image from the Internet and download it to the computer. .
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UNIT
8

Computer Protection

8.1: Introduction

8.2: Objectives of the Unit

8.3: Concept of Virus in Computer

8.4: Firewall Protection in Computer

8.5: Uses of Anti Virus for Security

8.6: Summary

8.7 Unit End Exercises

8.1 Introduction   

Computer protection, also known as computer security or cybersecurity, is the process of self 
safeguarding computer systems, networks, and data from unauthorized, accses, theft, damage and 
interruption.  

8.2 Objectives of the Unit
After reading of this unit learners will be able to-
•	 Understand what a computer virus is and how it damages a computer. 
•	 Learn about the various characteristics of computer viruses. 
•	 Define What is firewall, its types and use of firewall. 
•	 Understand how antivirus works for computer security. 

8.3 Concept of Virus in Computer 

A computer virus is a type of malicious software or program that attacks a computer in any way to 
destroy data and other files stored in computer memory and disrupts the functioning of the computer. 
Not only that, its destructive activity can gradually increase and cause huge financial losses by changing 
important computer files, databases or accounting records kept on the computer. The various ways in 
which a virus can attack a computer are- 
•	 Opening a virus infected file. 
•	 Running a virus-infected program on a machine. 
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•	 Using virus-infected copies, CDs or pen drives etc. on the machine. 
•	 Sometimes pirated software and viruses can be a means of attack. 
•	 Virus attacks can occur on computers via the Internet or email. 
•	 Email attachments are the easiest way to spread computer viruses.

Computer viruses were first conceptualized by David Gerroldi, although John Brunner provided 
detailed information about viruses. In his book he called the virus as Warm. In 1983 University of 
Cincinnati professor Fred Cohen created the first computer virus.

Different Types of Computer Virus.

Computer viruses are divided into several categories according to their capabilities and attack sites. 
These are highlighted below. 

Boot Sector Virus (Boot Virus): This virus attacks the boot sector and the information required to boot 
the computer causes distortion. 

Partition Table Virus: This type of virus attacks the partition table sector. These viruses become active. 
during booting of computer. 

File Virus: These types of viruses usually attack .com and .exe files. When any file of these types is 
executed the virus becomes active. 

Multi Paratite Virus: This type of virus attacks files and boot sector together. 

Macro Virus: This type of virus is usually contained in documents. 

Characteristics of Viruses 

The characteristics of computer viruses are explained below: 

Capacity to reproduce automatically 

After a virus attacks the computer from outside, the primary function of the virus is to create a 
large number of copies of itself and spread them within the computer. Computer viruses are often found 
in operating system files causes infection and the computer itself starts getting infected whenever the 
operating system is started. 

Migrate towards other Computers 

If any data, CD, pen drive, floppy, external hard disk etc. from one computer is used in another 
computer; the solo virus of the information is copied to other computers. On the other hand, viruses are 
transmitted through LAN, WAN, Internet. 

Resistance to vaccines 

Viruses usually reside in computer memory or become a resident of the computer system to protect 
themselves from antiviruses. Therefore, even if the virus copies of various files or documents can be 
removed by the antivirus, the computer remains infected. 
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Destruction or harmful actions 

A computer becomes uncontrollably harmful after being infected with a virus. Like ever computer 
hangs, deletes important data, corrupts data, freezes printers, disrupts normal CPU performance etc. 

8.4 Firewall Protection in Computer 

A firewall is a modern technical version of an old medieval security system, i.e. a moat between 
castles. Each palace has to be crossed over a bridge to enter and exit, and security or police check each 
entry and exit. The same approach can be followed for computers and networks. Let’s say a company 
is connected to a LAN and traffic to and from that company must go through a security or electronic 
bridge. In this case, the electronic bridge is the firewall. So it can be said that firewall is a private 
network protection device that verifies the access of information located on a computer or when sending 
information to the global network. Using a firewall keeps your network secure, because the firewall 
controls the flow of data or information. This is why firewalls are a popular network security system 
today. 

As per the above concept firewall has two components - Filter and Application Gateway 

Fig. 8.1 Firewall protection 

The figure below shows the internal structure of the firewall and its functionality. 

Fig. 8.2 Internal structure of firewall 

There are generally three types of firewalls-packet label firewalls, application level firewalls, and 
circle label firewalls. These are described below. 
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(a)	 Packet Label Firewall: The main function of packet level firewall is to filter the data packets. 
transported (incoming and outgoing) from one network to another network to see if they can reach 
the destination network according to the security policy. Eg-check point firewall is a packet level 
firewall. 

(b)	 Application Level Firewall: This type of firewall can analyze and filter application presentation 
data. For example, it can be said that the application gateway or firewall decides whether to send 
the message based on the action taken by analyzing the header field, message shape, subject etc. of 
the incoming or outgoing message on a mobile. Web proxy, mail server are examples of application 
level firewall. 

(c)	 Circuit Level Firewall: This type of firewall is similar to application level firewall. Circuit Level 
Firewall checks a network once it is connected and does not check data a second time once it is 
connected according to security rules. This type of firewall is known as circuit level firewall as it 
checks the security of the network through which data or information is exchanged. 

 Advantages and Disadvantages of using Firewall 

The advantages and disadvantages of using firewall are described below. 
Advantages: 
•	 Internal i.e. private networks can be protected using firewalls. 
•	 Sensitive, critical systems can be controlled and protected using firewalls. 
•	 It is also possible to keep statistics of network users using firewalls. 

Disadvantages: 
•	 Because of the complexity of replacing firewalls within the network i.e. configuration, except for 

skilled people, Firewalls cannot be replaced. 
•	 Despite the real benefits of using firewalls, small organizations do not use them because they are too 

expensive. 
•	 Firewalls have limitations in being known i.e. they are not universally known, hence widely used 

8.5 Uses of Anti Virus for Security 

The first antiviruses were used only to remove viruses from the computer, but today various 
antiviruses, apart from computer viruses, create a resistance against worms, phishing attacks, rootkits, 
etc. and remove them from the computer. helps to In this context, it should be noted that it is not only 
necessary to use antivirus, it must be updated constantly through the Internet. Updating increases the 
power of the antivirus and maintains its normal functionality. Antivirus can detect viruses through some 
methods. They are recorded below. 

Signature Based Detection 

This method has the highest virus detection. This viral signature is called viral code. If this viral 
code is found while scanning a file, the antivirus takes necessary action by completing the detection task 
mainly in three steps. These steps are Quarantining, Repairing and Deleting. 
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First, the antivirus makes the file inaccessible. Quarantine’s job is to encrypt the file. If the user wants to 
save the virus infected file, the antivirus tries to repair the file. If not repaired, the antivirus deletes the 
file and thus prevents against virus attacks. 
Heuristic Based Detection 

In heuristic based detection, viruses are detected by two methods, viz.-file analysis and file emulation. 
In file analysis, the antivirus analyzes the instructions contained in a program and based on the analysis. 
can tell whether the program is infected with a virus. In the file emulation method, the file is first run in 
a virtual system environment and the activity of the file is monitored. A file is marked as a virus if its 
instructions appear to be malicious. 

Behavioral Based Detection 

All types of programs are monitored in this manner. If a program tries to write data into an executable 
program, the antivirus identifies the program as a virus. Beside this using data mining techniques 
antiviruses can detect Viruses. 

‘Prevention is better than cure’ this is a common proverb. This applies equally to computers, so 
precautions should be taken before a virus attack occurs. There are various types of Antivirus software 
available in the market; some of them are Norton, Netwhield, Quick Heal, Avast etc. These softwares 
must be installed and updated regularly through the Internet. Here are some things to keep in mind: 
•	 If using a new floppy disk, pen drive, it must first be scanned on the computer. 
•	 Be cautious when opening information from an unknown source. 
•	 Antivirus should be run every day after opening the internet. 

Computer system data can be secured through the above methods. 

8.6 Summary
•	 A virus is a software program code that infects and damages a computer and in many cases destroys 

it completely. David Gerroldi gave the first idea of the first. 
•	 The main features of viruses are automatic replication, transmission from one computer to another, 

prevent protection and uncontrollably damage computers. 
•	 Firewall is a private network protection system to prevent unwanted information from entering into 

the computer or to check it if is sending to global network. 
•	 Antivirus is a software program that helps to keep computers free from viruses. 

8.7 Unit End Exercises 
(1)	 What is a virus? Viruses can be classified according to their potency and site of attack? 
(2)	 Write the characteristics of viruses. 
(3)	 What is antivirus? Describe the functions of antivirus. 
(4)	 What is firewall? Explain with picture how firewall works. 

Project Work 
(1)	 Scan any of the computers from the computer lab and a removable drive using antivirus software. 


